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Thank you for purchasing the Panasonic computer.  Read the operating instructions thoroughly for proper operation of your new
computer.

Illustrations and Terminology in this Manual

Copyright
This manual is copyrighted by Matsushita Electric Industrial Co., Ltd. with all rights reserved.  No part of this manual may be reproduced in any
form without the prior written permission of Matsushita Electric Industrial Co., Ltd.
No patent liability is assumed with respect to the use of the information contained herein.
©2003 Matsushita Electric Industrial Co., Ltd.  All Rights Reserved.

Disclaimer
Computer specifications and manuals are subject to change without notice.  Matsushita Electric Industrial Co., Ltd. assumes no liability for
damage incurred directly or indirectly from errors, omissions or discrepancies between the computer and the manuals.

Trademarks
Microsoft, Windows and the Windows logo are registered trademarks of Microsoft Corporation of the United States and/or other countries.
PS/2® is a registered trademark of International Business Machines Corporation.
Intel, Pentium, SpeedStep and PROSet are either registered trademarks or trademarks of Intel Corporation.
Adobe® and Acrobat® are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Panasonic is a registered trademark of Matsushita Electric Industrial Co., Ltd.

* For the Model No., insert the 12 digit number (for example, CF-29CTKGZKM) located on
the bottom of the computer.

NOTE: NOTE provides a useful fact or helpful information.
CAUTION: CAUTION indicates a condition that may result in minor or moderate injury.
WARNING: WARNING indicates a hazard that may result in moderate or serious injury.

Windows XP   : Information for Microsoft® Windows®  XP Professional users.
Windows 2000   : Information for Microsoft® Windows® 2000 Professional users.
Enter   : This illustration means to press the [Enter] key.
Fn   +   F5   : This illustration means to press and hold the [Fn] key,  then press the [F5] key.

[Start] - [Run]: This illustration means to click [Start], then to click [Run]. For some applications, you may need to
double-click.

: Where to go for referred information.
  : This illustration means to refer to the Reference Manual, which is available on your computer.

Refer to page 20 on how to access this manual.
Some of the illustrations in this manual may differ slightly in shape from the actual items in order to make the explanation
easier to understand.
The “CD Drive” is a description about drives, such as DVD-ROM, CD-ROM, CD-R/RW, and DVD-ROM & CD-R/RW
drives.
This manual covers two types of models, as distinguished by the type of LCD screen (models with touchscreen and models
without touchscreen).
If the user has logged on without the administrator authority, some functions may not be executable, and some screens may
be not displayed as shown in this manual.  If this happens, log on with the administrator authority to enable these functions.
Confirm the latest information on optional products in catalogs, etc.

Customer's Record

Serial No.

or

Date of Purchase

Model No.*

Code No.

Dealer's Name

Dealer's Address
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Read Me First

For Canada
Industry Canada (IC) Notice for modem
This equipment contains an Industry Canada approved modem unit.
The Industry Canada label is affixed on the modem unit.

EQUIPMENT ATTACHMENT LIMITATIONS
“NOTICE: The Industry Canada label identifies certified
equipment. This certification means that the equipment meets
telecommunications network protective, operational and
safety requirements as prescribed in the appropriate Terminal
Equipment Technical Requirements document(s). The
Department does not guarantee the equipment will operate
to the user’s satisfaction.
Before installing this equipment, users should ensure that it
is permissible to be connected to the facilities of the local
telecommunications company. The equipment must also be
installed using an acceptable method of connection. The
customer should be aware that compliance with the above
conditions may not prevent degradation of service in some
situations.
Repairs to certified equipment should be coordinated by a
representative designated by the supplier. Any repairs or
alterations made by the user to this equipment, or equipment
malfunctions, may give the telecommunications company
cause to request the user to disconnect the equipment.
Users should ensure for their own protection that the
electrical ground connections of the power utility, telephone
lines and internal metallic water pipe system, if present, are
connected together. This precaution may be particularly
important in rural areas. Caution: Users should not attempt
to make such connections themselves, but should contact
the appropriate electric inspection authority, or electrician,
as appropriate.”
“NOTICE: The Ringer Equivalence Number (REN) assigned
to each terminal device provides an indication of the
maximum number of terminals allowed to be connected to a
telephone interface. The termination on an interface may
consist of any combination of devices subject only to the
requirement that the sum of the Ringer Equivalence Numbers
of all the devices does not exceed 5.”
REN: See bottom of the computer

Industry Canada
This product complies with RSS210 Industry Canada.
Operation is subject to the following two conditions;
(1) this device may not cause interference, and
(2) this device must accept any interference, including interfer-

ence that may cause undesired operation of the device.

RESTRICTIONS CONCERNANT LE RACCORDEMENT
DE MATÉRIEL

“AVIS: L’étiquette d’Industrie Canada identifie le matériel
homologué. Cette étiquette certifie que le matériel est
conforme aux normes de protection, d’exploitation et de
sécurité des réseaux de télécommunications, comme le
prescrivent les documents concernant les exigences tech-
niques relatives au matériel terminal. Le Ministère n’assure
toutefois pas que le matériel fonctionnera à la satisfaction
de l’utilisateur.
Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il
est permis de le raccorder aux installations de l’entreprise lo-
cale de télécommunication. Le matériel doit également être
installé en suivant une méthode acceptée de raccordement.
L’abonné ne doit pas oublier qu’il est possible que la conformité
aux conditions énoncées ci-dessus n’empêche pas la
dégradation du service dans certaines situations.
Les réparations de matériel homologué doivent être
coordonnées par un représentant désigné par le fournisseur.
L’entreprise de télécommunications peut demander à
l’utilisateur de débrancher un appareil à la suite de
réparations ou de modifications effectuées par l’utilisateur
ou à cause de mauvais fonctionnement.
Pour sa propre protection, l’utilisateur doit s’assurer que tous
les fils de mise à la terre de la source d’énergie électrique,
des lignes téléphoniques et des canalisations d’eau
métalliques, s’il y en a, sont raccordés ensemble. Cette
précaution est particulièrement importante dans les régions
rurales. Avertissement: L’utilisateur ne doit pas tenter de faire
ces raccordements lui-même; il doit avoir recours à un ser-
vice d’inspection des installations électriques, ou à un
électricien, selon le cas.”
“AVIS: L’indice d’équivalence de la sonnerie (IES) assigné
à chaque dispositif terminal indique le nombre maximal de
terminaux qui peuvent être raccordés à une interface. La
terminaison d’une interface téléphonique peut consister en
une combinaison de quelques dispositifs, à la seule condi-
tion que la somme d’indices d’équivalence de la sonnerie
de touts les dispositifs n’excède pas 5.”
IES: Voir sous le fond de l’ordinateur

10.According to the FCC’s electrical safety advisory, we recom-
mend that you may install an AC surge arrestor in the AC out-
let to which this equipment is connected. Telephone compa-
nies report that electrical surges, typically lightning transients,
are very destructive to customer terminal equipment connected
to AC power sources and that this is a major nationwide prob-
lem.
“Caution: To reduce the risk of fire, use only No.26 AWG or larger telecom-
munication line cord.”
“ATTENTION: Pour réduire le risque d’incendie, utiliser uniquement des
conducteurs de télécommunications 26 AWG ou de section supérieure.”

Notice for the products using LCD
This product uses one or more fluorescent lamps containing a
small amount of mercury. It also contains lead in some compo-
nents. Disposal of these materials may be regulated in your com-
munity due to environmental considerations.  For disposal or
recycling information please contact your local authorities, or
the Electronics Industries Alliance: <http://www.eiae.org/>
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Important Safety Instructions / Importantes Mesures De Sécurité
When using  your telephone equipment, basic safety pre-
cautions should always be followed to reduce the risk of
fire, electric shock and injury to persons, including the fol-
lowing:

1.Do not use this product near water, for example, near a
bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2.Avoid using a telephone (other than a cordless type) dur-
ing an electrical storm. There may be a remote risk of
electric shock from lightning.

3.Do not use the telephone to report a gas leak in the vicin-
ity of the leak.

4.Use only the power cord and batteries indicated in this
manual. Do not dispose of  batteries in a fire. They may
explode. Check with local codes for possible special dis-
posal instructions.

SAVE THESE INSTRUCTIONS

Certaines mesures de sécurité doivent être prises pendant
l'utilisation de matérial téléphonique afin de réduire les
risques d'incendie, de choc électrique et de blessures. En
voici quelquesunes:

1.Ne pas utiliser l'appareil près de l'eau, p.ex., près d'une
baignoire, d'un lavabo, d'un évier de cuisine, d'un bac à
laver, dans un sous-sol humide ou près d'une piscine.

2.Éviter d'utiliser le téléphone (sauf s'il s'agit d'un appareil
sans fil) pendant un orage électrique. Ceci peut présenter
un risque de choc électrique causé par la foudre.

3.Ne pas utiliser l'appareil téléphonique pour signaler une
fuite de gaz s'il est situé près de la fuite.

4.Utiliser seulement le cordon d'alimentation et le type de
piles indiqués dans ce manual. Ne pas jeter les piles dans
le feu: elles peuvent exploser. Se conformer aux règlements
pertinents quant à l'élimination des piles.

CONSERVER CES INSTRUCTIONS

This product and your Health
This product, like other radio devices, emits radio frequency
electromagnetic energy. The level of energy emitted by this prod-
uct however is far much less than the electromagnetic energy
emitted by wireless devices like for example mobile phones.
Because this product operates within the guidelines found in
radio frequency safety standards and recommendations, we be-
lieve this product is safe for use by consumers. These standards
and recommendations reflect the consensus of the scientific com-
munity and result from deliberations of panels and committees
of scientists who continually review and interpret the extensive
research literature.
In some situations or environments, the use of this product may
be restricted by the proprietor of the building or responsible rep-
resentatives of the organization. These situations may for ex-
ample include:

Using this product on board of airplanes, or
In any other environment where the risk of interference to other
devices or services is perceived or identified as harmful.

If you are uncertain of the policy that applies on the use of wire-
less devices in a specific organization or environment (e.g. air-
ports), you are encouraged to ask for authorization to use this
product prior to turning on the product.

Regulatory Information
We are not responsible for any radio or television interference
caused by unauthorized modification of this product. The cor-
rection of interference caused by such unauthorized modifica-
tion will be the responsibility of the user. We and its authorized
resellers or distributors are not liable for damage or violation of
government regulations that may arise from failing to comply
with these guidelines.

Information to the User
Lithium Battery!
This computer contains a lithium battery to enable the date, time,
and other data to be stored. The battery should only be exchanged
by authorized service personnel.
Warning! A risk of explosion from incorrect installation or mis-
application may possibly occur.

Pile au lithium!
Le micro-ordinateur renferme une pile au lithium qui permet de
sauvegarder certaines données comme la date et l'heure
notamment. Elle ne devra être remplacée que par un technicien
qualifié.
Avertissement! Risque d'explosion en cas de non respect de cette
mise en garde!

Lithium Battery
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Care should be exercised with regard to the following in or-
der to avoid the possibility of overheating, fire or damage.

Avoid Heat
Do not throw the battery pack into a fire or ex-
pose it to excessive heat.

Do Not Disassemble
Do not insert sharp objects into the battery pack,
expose it to bumps or shocks, deform, disassemble,
or modify it.

Do Not Short
Do not short the positive (+) and negative (-) con-
tacts.

Do Not Put into a Microwave
Do not put the battery pack into a microwave oven
or a pressurized chamber.

Avoid Extreme Heat, Cold and Direct Sunlight
Do not charge, use or leave the battery pack for ex-
tended periods where it will be exposed to direct
sunlight, in a hot place (in an automobile on a sunny
day, for example), or in a cold place.

Keep Articles Away
Do not place the battery pack together with articles
such as necklaces or hairpins when carrying or stor-
ing.

Stop Using
Should the battery emit an abnormal odor, become
hot to the touch, become discolored, change shape,
or become in any way different from normal, remove
it from the computer or charger and stop using it.

Do Not Use With Any Other Computer
The battery pack is rechargeable and was intended
for the specified computer or charger.  Do not use it
with a computer other than the one for which it was
designed.

Do not touch the terminals on the battery pack.  The battery
pack may no longer function properly if the contacts are dirty
or damaged.
Do not expose the battery pack to water, or allow it to become
wet.

Read Me First

Avoid Radio Frequency Interference
Do not place the computer near a television or
radio receiver.

Precautions
The CF-29 was developed based on thorough research into the
real-world portable computing environments. Exhaustive pur-
suit of usability and reliability under harsh conditions led to in-
novations such has the magnesium alloy exterior, vibration
damped hard disk drive and floppy disk drive, flexible internal
connections. The CF-29’s outstanding engineering has been
tested using the stiff MIL-STD- 810F (for vibration and shock)
and IP (for dust and water) based procedures.
As with any portable computer device precautions should be
taken to avoid any damage. The following usage and handling
procedures are recommended.

Avoiding low-temperature burns
Avoid more than casual contact with any heat pro-
ducing area of  the notebook computer, AC adap-
tor, and any option or accessory you use with it.
Even low heat, if warmer than body temperature,
can cause a burn, if the skin is exposed to the heat
source for a long enough period of time.

Avoid Magnetic Fields
Keep the computer away from magnets.
Data stored on the hard disk may be lost.

Keep Small Objects Away
Do not insert paper clips or other small objects
into the computer.

Do Not Disassemble the Computer
Do not attempt to disassemble your computer.

Avoid Excessive Force on the Display
Do not apply excessive downward force on the
display when it is completely opened, especially
when plugs and/or cables are connected to the rear
of the computer.

Before putting the computer away, be sure to wipe off any mois-
ture.

Precautions (Battery Pack)
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NOTE
The battery pack may become warm during recharging
or normal use.  This is completely normal.
Recharging will not commence outside of the allowable
temperature range (0 °C to 50 °C {32°F to 122 °F})

  “Battery Power”.  Once the allowable range
requirement is satisfied, charging begins automatically.
Note that the recharging time varies based on the usage
conditions. (Recharging takes longer than usual when the
temperature is 10 °C {50 °F} or below.)
If the temperature is low, the operating time is shortened.
Only use the computer within the allowable temperature
range.
This computer has a high temperature mode function that
prevents the degradation of the battery in high tempera-
ture environments. (   “Battery Power”) If the
high temperature mode is enabled in the Setup Utility
(   “Setup Utility”), a level of 100% in the
[High Temperature] mode is about a level of 80% in the
[Normal Temperature] mode.
The battery pack is a consumable item.  If the amount of
time the computer can be run off a particular battery pack
becomes dramatically shorter and repeated recharging do
not restore its performance, the battery pack should be
replaced with a new one.
When transporting a spare battery inside a package, brief-
case, etc., it is recommended that it be placed in a plastic
bag so that its contacts are protected.
Always power off the computer when it is not in use.
Leaving the computer on when the AC adaptor is not
connected will exhaust the remaining battery capacity.

If the battery pack will not be used for a long period of time
(a month or more), charge or discharge (use) the battery pack
until the remaining battery level becomes 30% to 40% and
store it in a cool, dry place.
This computer prevents overcharging of the battery by re-
charging only when the remaining power is less than approx.
95% of capacity.
The battery pack is not charged when the computer is first
purchased.  Be sure to charge it before using it for the first
time.  When the AC adaptor is connected to the computer,
charging begins automatically.
Should the battery leak and the fluid get into your eyes, do not
rub your eyes.  Immediately flush your eyes with clear water
and see a doctor for medical treatment as soon as possible.

Precautions (Battery Pack)
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Names and Functions of Parts

(   “LED Indicators”)

(  page 18)

The illustrations shown may differ from the actual physical appearances.

LED Indicators (   “LED Indicators”)

(Only for models with touchscreen:
  “Touchscreen”)For information on the key combinations

available (  “Key Combinations”).

DC-IN Jack

Before using the computer for the first time, care-
fully read the [Limited Use License Agreement].
If you agree to the conditions, remove the seal.

Power Switch

For enhanced portability and in-
the-field efficiency.

Caps lock
Numeric key lock (NumLk)
Scroll lock (ScrLk)
Multimedia pocket device status
Hard disk drive status
Power status of the multimedia pocket

Battery pack status
Power status

Carrying Handle

Touch Pad

Function Keys

DC IN 15.6V

(   “USB Devices”)

(   “LAN”)

(   “Modem”)

(   “PC Cards”)

LAN

PC Card slots

Modem

(   “Hard Disk Drive”)
Hard Disk Drive

(   “Battery Power”)
Battery Pack

LED Indicators

(   “Multimedia Pocket”)
Multimedia Pocket (Floppy Disk Drive)

USB Port

Keyboard

LCD

(   “Wireless LAN”)
Wireless LAN Antenna
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Serial Port

Expansion Bus Connector
(   “Port Replicator”)

External Keyboard/Mouse Port

NOTE
When using a external microphone, do not remove the
check mark for “Mute” under “Microphone Balance”
of the Volume Control dialog box and do not increase
the playback volume. Howling may result. Howling may
occur in the same way when disconnecting an external
microphone. (The microphone of “Volume Control” is
in the state of mute at the time of factory shipment. This
is not shown at the time of factory shipment.)

A lithium ion battery that is recyclable powers the product you have purchased.  Please call 1-800-8-
BATTERY for information on how to recycle this battery.

L’appareil que vous vous êtes procuré est alimenté par une batterie au lithium-ion. Pour des
renseignements sur le recyclage de la batterie, veuillez composer le 1-800-8-BATTERY.

(   “External Display”)

Parallel Port

Use this connector to connect
headphones  or  ampl i f ie r -
equipped speakers.  Audio out-
put from the internal speaker is
disabled when headphones or
external speakers are connected.

Headphone Jack

(   “RAM Module”)

Use only a monaural condenser microphone (miniature jack).
Using an input source other than a monaural condenser micro-
phone may not allow audio to be input or may damage the
equipment.

Speaker
To adjust the volume:
  Fn   +   F5   /   Fn   +   F6
Speaker on/off :   Fn   +   F4

RAM Module Slot

Security Lock
A cable can be connected to pre-
vent theft of your computer.  For
more information, read the
manual that comes with the cable.

LOCK

External Display Port

Microphone Jack
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2 Read the LIMITED USE LICENSE AGREEMENT. (  page 32)
Before removing the seal covering the power switch, read the LIMITED USE
LICENSE AGREEMENT.

3 Insert the battery pack.
1 Unlock the cover by sliding the latch to the right.

First-time Operation
Read the steps below to help you learn what parts are included, and to gain an understanding of
some basic computer-related operations.

1 Confirm the inclusion of all parts
Make sure the parts shown in the figure have been supplied.  If any of these items are
missing or are not working properly, contact Panasonic Technical Support.

Model No : CF-AA1653A

Model No : CF-VZSU29

Operating Instructions (This book) ............................................................. 1
Windows® Book ...................................................................................... 1
Product Recovery CD-ROM

Windows XP ............................................................................................ 3
Windows 2000 ......................................................................................... 2

(   “Touchscreen”)

Soft Cloth .................................. 1 Stylus ..................................... 1

<Only for models with touchscreen>

Battery Pack.............................. 1 Modem Telephone Cable .......... 1

AC Adaptor ............................... 1 AC Cord ..................................... 1

Latch

2 Slide the latch down, and then without releasing it, open the cover as illustrated.

Cover
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6 Turn your computer on.
Slide the power switch and hold it for approximately one second until the power indi-
cator turns on before releasing it.

Do not slide the power switch and hold it for more than four seconds; this will
cause the power to be turned off forcibly.
Do not slide the power switch repeatedly.
Once the computer is powered off, you must wait at least ten seconds before
powering it on again.

4 Connect your computer to a power outlet.

Be sure the AC adaptor is connected until completing the first-time use opera-
tion.
When using the computer for the first time, do not connect any peripheral
device except the battery pack and AC adaptor to the computer.

Handling the AC adaptor
Do not twist or pull the AC power cord forcefully.  Doing so may damage the
connections.
Use only the specified AC adaptor with your computer.  Using an AC adaptor
other than the one supplied might damage the battery and/or the computer.
When the DC plug is not connected to the computer, disconnect the AC cord
from your AC wall outlet.
Problems such as sudden voltage drops may arise during periods of thunder
and lightning.  Since this could adversely affect your computer, an
uninterruptible power source (UPS) is highly recommended unless the battery
pack is installed.

Power Indicator 

CAUTION

CAUTION

5 Open the display.
1 Pull the carrying handle forward.
2 Press the latch as illustrated to release it from the computer.
3 Lift up the latch and open the display.

CAUTION
Do not touch the terminals on the battery pack and the computer. The battery
pack may no longer function properly if the contacts are dirty or damaged.
Also, the computer may not operate properly.
Be sure to insert the battery pack as illustrated.

3 Slide the battery pack inward until it is firmly in place.

4 Close the cover, then lock it by sliding the latch to the left.

CAUTION
Confirm that the latch lock is correctly in place. If you carry your computer
without the latch lock in place, the battery pack may fall out.
Before using the battery pack, carefully read “Precautions (Battery Pack)”
(  page 6-7).

DC-IN Jack

DC IN 15.6 V

DC Plug

Power Switch 

3

4

1

2
3

Latch
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First-time Operation

7 Setup Windows.
Moving the cursor ( ) or clicking buttons can be performed with the touch pad.

The touchscreen does not work properly during the Windows setup.
During the Windows setup procedure, the desktop will be displayed as a small
screen in the center of the LCD.  After the setup procedure is completed and the
computer is restarted, the desktop will be displayed as a full screen.

NOTE

Select settings for your region, then select [Next].
4 Enter your name and organization and then select [Next].
5 Enter your computer name and administrator password and then select [Next].

Do not press any keys or touch the touch pad until [Windows XP Professional
Setup] is displayed.

CAUTION

Windows XP

1 At [Welcome to the Windows XP Setup Wizard], select [Next].
2 After reading the agreement, select [I accept this agreement] or [I don’t accept this

agreement], then select [Next].

NOTE
If [I don’t accept this agreement] is selected, the Windows setup will be aborted.

3

CAUTION
Remember this password!  If the password is forgotten, Windows cannot be
operated.

7 At [Networking Settings], select [Typical settings], then select [Next].
8 At [Workgroup or Computer Domain], select [No, this computer is not on a network,

or is on a network without a domain], then select [Next].
The computer will restart.

NOTE
It may take two to three minutes until the next screen is displayed.  Wait, and do
not press any keys, or touch the touch pad, etc.

 If “Yes, make this computer a member of the following domain” is selected, the
following message may be displayed: [An invalid domain was specified. Would
you like to proceed for now and try joining a domain later?]. In this case, select
[Yes]. After selecting [Yes], the computer will restart automatically, but some-
times the [Starting Windows] message will remain on the screen, and windows
will not start up. If this happens, hold    Alt   down while pressing   Tab   until
[Network Identification Wizard] is displayed on top, and follow the instruc-
tions on the screen.

NOTE

6 Enter the correct date, time and the time zone, then select [Next].
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NOTE
If [Windows XP is currently configured to manage the Intel(R) PRO/Wireless LAN
adaptor.] is displayed, select [Yes].

9 Enter your administrator password and select .
Wait until the hard disk drive indicator ( ) has turned off.

Remember this password!  If the password is forgotten, Windows cannot be
operated.

CAUTION

1 At [Welcome to the Windows 2000 Setup Wizard], select [Next].
2 After reading the agreement, select [I accept this agreement] or [I don’t accept this

agreement], then select [Next].

If [I don’t accept this agreement] is selected, the Windows setup will be aborted.
NOTE

3 Select settings for your region, then select [Next].
4 Enter your name and organization and then select [Next].
5 Enter your computer name and administrator password and then select [Next].

Do not press any keys or touch the touch pad until [Windows 2000 Professional
Setup] is displayed.

CAUTION

Windows 2000

6 Enter the correct date, time and the time zone, then select [Next].
7 At [Networking Settings], select [Typical settings], then select [Next].
8 At [Workgroup or Computer Domain], select [No, this computer is not on a

network, or is on a network without a domain], then select [Next].
The computer will restart.

9 At [Welcome to the Network Identification Wizard], select [Next].
10 At [Users of This Computer], select [Users must enter a user name and password to

use this computer], then select [Next].
11 Select [Finish].
12 Enter your administrator password and select [OK].

Wait until the hard disk drive indicator ( ) has turned off.

8 <Only for models with touchscreen>
Calibrate the touchscreen.

1 Select [Start] - [Settings] - [Control Panel] - [Mouse] - [TouchScreen] - [Calibration].
2 Touch the “+” mark on the calibration screen  with the stylus (included) for about one second.
3 After the calibration procedure is executed (e.g., after the nine “+” marks are touched),

the procedure ends when   Enter   is pressed.

Windows 2000

1 Select [Start] - [Control Panel] - [Printers and Other Hardware] - [Mouse] -
[TouchScreen] - [Calibration].

2 Touch the “+” mark on the calibration screen  with the stylus (included) for about one second.
3 After the calibration procedure is executed (e.g., after the nine “+” marks are touched),

the procedure ends when   Enter   is pressed.

Windows XP
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This concludes the first-time use operation guidelines.

Information for Windows XP
Depending on the Windows settings, installed applications, and drivers, menus and other
displays may differ, or some functions (such as use of the password reset disk) may be
inoperable.

You can select Classic view for the Control Panel or select the Classic Start menu.  You can
also change the way a user logs on or off.
The procedure in this manual uses the method of the Windows XP default setting (not  Clas-
sic Start menu etc.).

Resetting the password
Windows XP has a function to reset a forgotten password.
To use this function, you need to create a password reset disk beforehand following the steps
below.
1 Select [Start] - [Control Panel] - [User Accounts].
2 Select [Prevent a forgotten password] from the [Related Tasks] menu of the account you

have logged on to and create a password reset disk following the on-screen instructions.
Store the password reset disk in a safe place.
• Only the logon password for each account can be reset.

The password set in the Setup Utility cannot be reset.

NOTE
If you use the wireless LAN, be sure to refer to the Reference Manual’s “Wireless
LAN”.

9 Windows XP
Create a new account.

1 Select [Start] - [Control Panel] - [User Accounts] - [Create a new account].
2 Follow the instructions on the display to create a user account.
3 Select [Start] - [Turn Off Computer] - [Restart] to restart the computer.

CAUTION
Remember this password!  If the password is forgotten, Windows cannot be oper-
ated.  You can create a password reset disk beforehand (  below).

When creating a new user account:
If you make mail settings, create password reset disks (  below), or conduct
other related operations before creating the user account, you will be unable to use
any previous mail history or settings.
When you create the first new account, you can only select [Computer administra-
tor].
Once a “Computer Administrator” account has been created, you can create addi-
tional limited user accounts.
Note also that only the added user account will be displayed in the Welcome screen.
The account for the administrator created during Windows setup will not be dis-
played.

NOTE

First-time Operation
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1 Open the display.

Starting Up/Shutting Down

Starting Up

2 Turn your computer on.
Slide the power switch and hold it for approximately one second until the power indicator
turns on before releasing it.

Under the condition that both the AC adaptor and the port replicator are not con-
nected, the power will not go on if the display is closed.
While booting, avoid the following until the hard disk drive indicator ( ) has turned
off.
• Connecting or disconnecting the AC adaptor.
• Touching the power switch.
• Performing any keyboard, touch pad, touchscreen (only for models with touch-

screen), or external mouse operations.
• Closing the display.
Once the computer is powered off, you must wait at least ten seconds before pow-
ering it on again.
When the CPU temperature rises, the computer may not power on to prevent the
CPU from overheating.  Should this happen, allow the computer to cool down then
switch the power on again.
If the computer still does not power on, contact Panasonic Technical Support.

CAUTION

1 Pull the carrying handle forward.
2 Press the latch as illustrated to release it from the computer.
3 Lift up the latch and open the display.

Three incorrect attempts
or

No password for about a minute

The correct password
Will Start

Enter your password*1 and press   Enter   . (   “Security Measures”)

 Will Not Start
(Power off)

If [Enter Password] is displayed

*1Supervisor Password or User Password set in the Setup Utility (not
the Windows password).

Enter Password [        ]

When the power is turned on, sometimes the message “Warming up the system” is
displayed or the battery indicator alternately blinks green and orange, and start-up
takes longer than usual (a few minutes or more).  This function is designed to prevent
hard disk drive malfunctions that may occur at low temperatures.  Please wait for the
computer to start up.

NOTE

Power Indicator 

Power Switch 

When an application or file that was previously displayed
appears on your screen
The standby or hibernation mode has been set (   “Standby/Hibernation Func-
tions”).

1

2
3

Latch
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Starting Up/Shutting Down

The power saving function is factory set, so if there is no input from a key, the touch
pad, the touchscreen (only for models with touchscreen) or an external mouse (when
one is connected) for a certain interval of time, the power to the LCD and hard disk may
be turned off.  The LCD will resume operation when the touch pad, the touchscreen
(only for models with touchscreen) or an external mouse (when one is connected) is
used or a key is pressed.
The power to the LCD may be turned off even when an application software is being
installed.  In this case, because it is conceivable that a selection dialog box will be
shown, do not press    Space    or    Enter     to attempt to resume from this condition
as doing so may trigger a selection, but instead, press a key unrelated to the direct
triggering of a selection, like   Ctrl  .
In addition, when the computer is left alone, it automatically enters the standby or hiber-
nation mode (    “Standby/Hibernation Functions”).  The computer will re-
sume by sliding the power switch.

Windows XP
When switching to a different user with the Fast User Switching function, it may not be
possible to set the settings of the display. In this case, log off all users, and try the
operation once more. If the problem persists, restart the computer.

NOTE

3 Log on to Windows.
Windows XP

After confirming that the hard disk drive indicator ( ) has turned off, select the user and
input the password, then select .  Until the correct password is entered, the computer
will not operate.

Windows 2000
After confirming that the hard disk drive indicator ( ) has turned off, input the user name
and password, then select [OK]. Until the correct user name and password are entered, the
computer will not operate.

4 Select your application.
You are able to start working on your computer.
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Shutting Down (power off your computer)

3  Windows XP

Select [Turn Off].
  Windows 2000

Select [Shut down], then select [OK].
Your computer will power off automatically.

Restarting your computer (without shutting down)
Windows XP

Select [Restart].
Windows 2000

Select [Restart], then select [OK].

To shut down using the keyboard,
Windows XP

Press       ,   U   , and select [Turn Off] with                    , then press    Enter   .

Windows 2000
Press       ,   U   , and select [Shut down] with                    , then press    Enter   .

To quickly resume computer operation after shutting down,
The standby or hibernation function is available (   “Standby/Hibernation
Functions”).

NOTE

This procedure is for shutting down the computer without using the standby or hibernation
function (   “Standby/Hibernation Functions”).

1 Save important data and close each application.

2  Windows XP

Select [Start] - [Turn Off Computer].

  Windows 2000
Select [Start] - [Shut Down].

CAUTION
Do not do the following during the shutdown/restart procedure.
• Connecting or disconnecting the AC adaptor.
• Touching the power switch.
• Performing any keyboard, touch pad, touchscreen (only for models with

touchscreen), or external mouse operations.
• Closing the display.

4 Close the display until the latch clicks into place.
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Function

Touch Pad (Basic Operation)

Use the touch pad to move the cursor on the display and perform normal computer operations.
For instructions on how to operate, refer to   "Touch Pad".

If a key combination such as   Fn   +   F5    is used while the pad is being touched, the
function of the key combination will not work.  In addition, it is possible that control of the
cursor will be lost and the cursor will not show proper movements.  In such cases, the
computer has to be restarted by using the keyboard (e.g.,      ).
Do not place any object on the work surface or press down forcefully with sharp-pointed
objects (e.g., nails) or hard objects that can leave marks (e.g., pencils and ball point pen).
Try to avoid having any harmful substances such as oil, come in contact with the touch
pad.  The cursor may not work properly in such cases.
When the touch pad becomes dirty:
Wipe to remove dirt by using a dry soft cloth such as gauze or a soft cloth first applied with
detergent diluted with water and then thoroughly wrung.
Do not use benzene, thinner, or rubbing alcohol. Doing so may adversely affect the sur-
face, e.g., discoloration.  In addition, do not use commercially-available household clean-
ers and cosmetics, as they may contain components harmful to the surface.

or

Two quick taps, but on the
second tap leaving your
finger down (applying
pressure) and moving it
on the work surface.

While holding down
the button, moving
your finger on the
work surface.

or

Touch Pad Operation
Moving the Cursor

Tapping/Clicking

Double-Tapping/
Double-Clicking

Dragging

or

Move the tip of your finger lightly over
the surface.

tapping clicking

double-clicking

Handling the Touch Pad

Left Button

Right Button

Work Surface

double-tapping

CAUTION
By design the touch pad is to be used with a finger tip only.  Therefore, do not use any
implement which causes damage on the work surface.



19

O
pe

ra
tio

n

Reference Manual
The Reference Manual and the Important Tips can be accessed on your computer. When a
printer is connected, these manuals can also be printed.

The Reference Manual explains functions for you to make greater use of the computer, such
as how to add peripheral devices, how the Setup Utility works, and other useful information.
(Refer to the cover of this manual for a list of the main contents included.)
Important Tips provides information on how to maximize use of the battery pack, which is
necessary for computing away from your home or office.
It also offers helpful explanations on how to use the touchscreen more effectively. (only for
models with touchscreen)

Illustrations may be difficult to view depending on the magnification.  If the illustra-
tion is too small, magnify the display.
The characters in PDF files (such as the Reference Manual) may be difficult to read
depending on the Acrobat Reader settings and the Windows Desktop settings. In such
cases, change the Acrobat Reader settings with the following procedure.
1 Start up Acrobat Reader.
2 Select [Edit] - [Preferences] - [Accessibility], and then set [Color Scheme] to [Use

colors specified in document].
When the taskbar is hidden at the bottom portion of Acrobat Reader, set the maximum
display window size.
If a printer is connected, we recommend printing pages.  The illustrations and display
samples may not print with a high quality.

NOTE

Opening the Reference Manual or Important Tips

Reference Manual
Windows XP

Select [Reference Manual] in [Start].
Windows 2000

Select [Reference Manual] in [Start] - [Programs] - [Panasonic] -
[On-Line Manuals].

Important Tips
Select  on the desktop.
Important Tips can also be accessed from the following menu.

Windows XP
Select [Important Tips] in [Start] - [All Programs] - [Panasonic] - [On-Line Manuals].

Windows 2000
Select [Important Tips] in [Start] - [Programs] - [Panasonic] - [On-Line Manuals].

When the Reference Manual or Important Tips is started up for the first time, the License Agree-
ment of the Acrobat Reader may be displayed. If it is displayed, after reading the agreement,
select [Accept] to access the Reference Manual or Important Tips.
Refer to Acrobat Reader Help to use the Acrobat Reader.
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Useful Information

Environment
In use: Temperature: 5 °C to 35 °C  {41 °F to 95 °F}

Humidity     : 30% to 80% RH  (No condensation)
Not in use: Temperature: -20 °C to 60 °C  {-4 °F to 140 °F}

Humidity     : 30% to 90% RH  (No condensation)
 Places not to use your computer

Such areas may result in damage to the computer.
Areas with electronic equipment

These areas may interfere with your display or cause your computer to produce strange
sounds.

Areas with extremely high/low temperatures
Do not leave things near the computer that are sensitive to heat.  During operation, the
computer may become warm.

Usage Environment

Handling
This computer has been designed so as to minimize shock to the LCD and hard disk drive, the
leakage of liquid (e.g., water) on to the keyboard, etc., but no warranty is provided against
such trouble.  Therefore, as a precision instrument, be extremely careful in the handling.
Do not drop or hit your computer against solid objects.
Do not carry your computer when it is on.
Remove all external devices, cables, and PC Cards sticking out of the computer (see the
figure on the left) before transporting the computer.
We recommend preparing a fully charged battery (and optional charger, if possible).
When transporting spare batteries inside a package, briefcase, etc., it is recommended that
the batteries be stored in a plastic bag.
Do not place the computer upright or allow it to tip over.  When the computer receives
extremely strong shock after falling, the hard disk or floppy disk drive, etc., may become
inoperable.
Do not carry the computer while the display is open, or carry it by gripping the display.
Do not put anything (e.g., a piece of paper) between the display and keyboard.
Always carry your computer with you when traveling.  Never check it in with luggage.  For
use of the computer inside an aircraft, we recommend asking the airlines regarding their
policy on this issue.
It is a good idea to make backup copies on disks and carry them with you.
Do not leave a disk in the drive while transporting your computer.
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Maintenance

Touch Pad
 page 19

Do not use benzene, thinner, or rubbing alcohol.  Doing so may adversely affect the sur-
face, e.g., discoloration.  In addition, do not use commercially-available household clean-
ers and cosmetics, as they may contain components harmful to the surface.
Do not directly add or spray water or detergent.  If liquid enters the inside of the com-
puter, it may cause it to work improperly or be damaged.

Display
<Models with touchscreen>
Use the Soft Cloth included with the computer. (For more information, refer to “Suggestions
About Cleaning the LCD Surface” that come with the soft cloth.)
If the Protective Film becomes dirty or damaged, it may be time to replace your Protective
Film. The Protective Film is a disposable item. To find out the model number of your Protec-
tive Film, contact Panasonic Technical Support. (For more information, refer to the “Operating
Instructions” that come with the Protective Film.)

<Models without touchscreen>
Avoid using water when cleaning the panel.  Ingredients included in water may leave residue
and reduce readability of the screen.
<When cleaning dust/dirt>
Avoid rubbing off dust/dirt with cloth since it may leave scratch on the screen.
Sweep dust/dirt with fine brush, then wipe it with “dry” soft cloth used for cleaning glasses.
<When cleaning oily surface>
Apply camera lens cleaner on a soft gauze and clean it with gentle force. Then, wipe  with dry
soft cloth used for cleaning glasses.

CAUTION

Areas excluding the display
Wipe these areas with a soft cloth, after applying water or detergent diluted with water to the
soft cloth and firmly wringing out excess water.

Do not touch or use a touchscreen before you re-attach a Protective Film, as you may leave
a mark or a scratch on the touchscreen.

CAUTION

Saving Data on the Hard Disk
Do not expose your computer to shock.
Use care when handling your computer, shock may damage your hard disk or make your
software applications and data unusable.
Do not power off your computer while software applications are running or hard disk drive indica-
tor ( ) is on.
Properly shut Windows* down to avoid problems.
Save all valuable data to floppy disks, etc.
Backing up data to floppy disks, etc. will limit damage should trouble occur to your com-
puter or should you inadvertently change or erase data.
Use the security function for all important data.  (   “Security Measures”)

* Windows XP    : This computer uses Microsoft® Windows® XP Professional.
Windows 2000    : This computer uses Microsoft® Windows® 2000 Professional.

Hard Disk Lock
When the Hard Disk Lock is set to [Enable], it is impossible to read/write data from/to the
hard disk when the hard disk is installed in a different computer, since a password is also set
for the hard disk.  When the hard disk is returned to the original computer, you can read and
write data as before.  In this case, however, make the settings in the Setup Utility exactly the
same as they were before the hard disk was removed.  (Note that this Hard Disk Lock does
not guarantee complete protection of data.) (   "Security Measures")
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Useful Information

When Using Peripheral Devices
Pay strict attention to the following points to avoid damage to the computer, peripheral de-
vices, cables, etc.  Also, in addition to following this manual and the Reference Manual, care-
fully read the instruction manuals for the peripheral devices being used.

Use only peripheral devices that conform to the computer’s specifications.
Connect the devices properly, paying close attention to the condition and position of the
connectors.
If a connection cannot be made easily, do not apply undue force; check once more to con-
firm the condition and position of the connector (alignment of pins, etc.) .
If the connector has holding screws, fasten the screws firmly.
Do not carry the computer with cables attached, and do not pull on the cables forcefully.

Users are advised to purchase the latest versions of virus protection software and use
them regularly.

We recommend you run the software:
• After booting your computer.
• After receiving data.
We recommend that you check data received on disks or from external sources, such as data
downloaded from the Internet, e-mail, etc.  (For compressed files, uncompress them before
running a check).

Computer Viruses

Do not power down your computer or press the disk eject button while the MP indica-
tor ( ) is on.
Doing so may damage the data on the floppy disk and render the floppy disk useless.
Use care when handling floppy disks.
To protect the data on your floppy disks or to prevent a floppy disk from becoming stuck in
your computer, avoid the following:
• Sliding the shutter on the floppy disk manually.
• Exposing the floppy disk to a magnetic field.
• Storing the floppy disk in locations prone to high temperatures, low pitched noise, damp-

ness, or dust.
• Applying more than one label on the floppy disk.
Confirm the contents of a floppy disk before formatting it.
Confirm that no important data is on the floppy disk, because all data on the floppy disk
will be erased.
Use the write-protect tab.
This is a must for preserving important data.  This prevents your data from being erased or over-
written.

Write Enable

Write Disable

Write-protect Tab

Saving Data on Floppy Disks

To prevent theft of data or unauthorized access to the hard disk via a wireless LAN.
If you plan to use wireless LAN functions, we recommend that you do so only after making
the appropriate security settings, such as for data encryption.

Wireless LAN
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When Disposing of or Transferring Ownership of This Device
When disposing of or transferring ownership of this device, erase all data on the hard disk in
order to prevent the theft of hard disk data. Even if you delete data or initialize the hard disk
through normal Windows commands, data can still be read using special software. In order to
erase all data, either have the data erased by a specialist (at a charge) or use the hard disk data
erase utility (included) (  page 38).  (Note that this hard disk data erase utility does not guar-
antee that data will be completely erased.)
Also, note that if you transfer ownership of this device without deleting commercial soft-
ware that you have installed to the hard disk, you may be in violation of the licensing
agreement for that software.

When Changing Hard Disk Partitions

When using the hard disk backup function (  page 34), do not divide up the hard disk before
creating a backup region. If you do this, the backup region cannot be created. Divide into the
partition when the backup region is created.

Windows Update
You can use the latest patches and service packs for Windows with the following menus.
Do not apply "Driver Update" even if a message to update a driver appears. If a driver
update is required, contact to Panasonic Technical Support.

Windows XP
[Start] - [All programs] - [Windows Update]

Windows 2000
[Start] - [Windows Update]
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List of Error Codes
The following is a list of the messages that BIOS can display. Most of them occur during POST. Some of them display
information about a hardware device, e.g., the amount of memory installed. Others may indicate a problem with a device,
such as the way it has been configured. Following the list are explanations of the messages and remedies for reported
problems.
If your system displays any of the below error messages other that the ones marked with an asterisk (*), write down the
message and contact Panasonic Technical Support. If your system fails after you make changes in the Setup menus, reset the
computer, enter Setup and install Setup defaults or correct the error.

0200 Failure Fixed Disk
Fixed disk in not working or not configured properly. Check to see if fixed disk is attached properly. Run Setup.
Find out if the fixed-disk type is correctly identified.

0211 Keyboard error
Keyboard not working.

0212 Keyboard Controller Failed
Keyboard controller failed test. Requires repair of system board.

0213 Keyboard locked - Unlock key switch
Unlock the system to proceed.

0230 System RAM Failed at offset : nnnn
System RAM failed at offset nnnn of in the 64k block at which the error was detected.

0231 Shadow RAM Failed at offset : nnnn
Shadow RAM failed at offset nnnn of the 64k block at which the error was detected.

0232 Extended RAM Failed at offset : nnnn
Extended RAM Failed at address line : nnnn
Extended memory not working or not configured properly at offset or address line nnnn.

0250 System battery is dead - Replace and run SETUP
The CMOS backup battery is dead. Replace the battery and run Setup to reconfigure the system.

*0251 System CMOS checksum bad - Default configuration used
System CMOS has been corrupted or modified incorrectly, perhaps by an application program that changes data stored in CMOS. The
BIOS installed Default SETUP Values. If you do not want these values, enter Setup and enter your own values. If the error persists, check
the system battery or contact Panasonic Technical Support.

0260 System timer error
The timer test failed. Requires repair of system board.

0270 Real time clock error
Real-time clock fails BIOS test. Requires repair of system board.

0271 Check date and time settings
Real-time clock is illegal.  Run Setup and set the date and clock.

*0280 Previous boot incomplete - Default configuration used
Previous POST did not complete successfully. POST loads default values and offers to run Setup. If the failure was caused by incorrect
values and they are not corrected, the next boot will likely fail. On systems with control of wait states, improper Setup settings can also
terminate POST and cause this error on the next boot. Run Setup and verify that the wait-state configuration is correct. This error is cleared
the next time the system is booted.

02D0 System cache error - Cache disabled
Contact your Panasonic Technical Support.

Failing Bits : nnnn
The hex number nnnn is a map of the bits at the RAM address which failed the memory test. Each 1 (one) in the map indicates a failed bit.
See error 230,231 or 232 for offset address of the failure in System, Extended or Shadow memory.

Operating System not found
Operating system cannot be located on either drive A: or drive C:. Enter Setup and see if fixed disk and drive A: are properly identified.

Press <F1> to resume, <F2> to Setup
Displayed after any recoverable error message. Press <F1> to start the boot process or <F2> to enter a Setup and change the settings. Write
down and follow the information shown on the screen.

0614 Serial Port A config. error - device disabled
0616 Serial Port B config. error - device disabled

Serial Device I/O Address or IRQ are in conflict.  Change the I/O Address or IRQ in the Setup Utility.



25

Tr
ou

bl
es

ho
ot

in
g

The power indicator or bat-
tery indicator is not lit

The computer does not op-
erate when a USB device is
connected
[Enter Password] is dis-
played
POST Startup Error(s) is
displayed
Windows startup, or an op-
eration is extremely slow

The date and time are incor-
rect

When resuming from the
standby or hibernation
mode, [Enter Password]
does not appear even if a
password has been set in the
Setup Utility

When “Invalid system disk.
Replace the disk, and then
press any key.” (or a similar
message) is displayed

When a problem occurs, refer to this page.  The “Reference Manual” also contains detailed information.  If a problem appears to be
related to a software application, read the software related manual.  If you still cannot troubleshoot the problem, contact Panasonic
Technical Support. You can use the PC Information Viewer to check the computer’s usage status. (   “Dealing with
Problems (Advanced)”)

Dealing with Problems (Summary)

 Starting Up
Check the cable connection for the AC adaptor.
Check to see if a fully charged battery is properly installed.
Remove the battery pack and disconnect the AC adaptor, then connect them again.
The computer may not operate when certain USB devices are connected.  Disconnect the
USB device, or set [Legacy USB Support] to [Disable] in [Security] menu of the Setup
Utility.

Input your Supervisor Password or User Password. If you have forgotten it, contact Pana-
sonic Technical Support.

 page 24

Press   F9   in the Setup Utility (   “Setup Utility”).   This will restore the Setup
Utility's settings to their default values (except the password settings).  Then, the Setup
Utility must be run once again for you to input the appropriate operating environment
settings.  (The processing speed depends on the application software used, so this opera-
tion may not cause the processing speed to increase.)
You can set the date and time using the following menu.

Windows XP
[Start] - [Control Panel] - [Date, Time, Language, and Regional Options] - [Date and Time]

Windows 2000
[Start] - [Settings] - [Control Panel] - [Date/Time]

  When the computer is connected to a LAN, confirm the date and time of the server.
If you continue to experience problems, the internal battery maintaining the clock may
need to be replaced.  Contact Panasonic Technical Support.

  This computer will not correctly recognize the date and time starting from the year 2100
A.D.
Even when a password has been set in the Setup Utility, [Enter Password] does not
appear when the computer resumes from the standby or hibernation mode.
If you want to use the security function when using the standby or hibernation mode, use
the Windows password as follows:
   Windows XP
Select the account to change in [Start] - [Control Panel] - [User Accounts] and set the
password, then add the check mark for [Prompt for password when computer resumes
from standby] in [Control Panel] - [Performance and Maintenance] - [Power Options] -
[Advanced].
  Windows 2000
Set the password in [Start] - [Settings] - [Control Panel] - [Users and Passwords], then
add the check mark for [Prompt for password when computer goes off standby] in
[Control Panel] - [Power Options] - [Advanced].
This means a floppy disk that does not contain system startup information has been left in
the floppy disk drive.  Remove the floppy disk, and press any key.
This message may appear when certain USB devices are connected.  Remove the USB
device, or set [Legacy USB support] in [Security] menu of the Setup Utility to [Disable].
If the message still appears even after trying the above two measures, this may be an indica-
tion that some type of hard disk failure has occurred.  Contact Panasonic Technical Support.
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Dealing with Problems (Summary)

When the administrator
password is forgotten

When the previous item is
not the cause

 Starting Up (continued)
Set the password again in the following procedure.
  Windows XP
If you have created a password reset disk (  page 14 ), a message is displayed when
you fail to correctly enter the password. Follow the message’s instructions and set the
password again by using the password reset disk.
If you have not created a password reset disk, after reinstalling, setup Windows and then
set the password again.
   Windows 2000
After reinstalling, setup Windows and then set the password again.

Press   F9    in the Setup Utility (   “Setup Utility”).   This will restore the Setup
Utility’s settings to their default values (except the password settings).
Try removing all peripheral devices.
Check a disk error using the following procedure.
1 Display [Local Disk(C:) Properties].

Windows XP
Select [Local Disk(C:)] with the right button in [start] - [My Computer], and select
[Properties].

Windows 2000
Select [Local Disk(C:)] with the right button in [My Computer], and select [Properties].

2 Select [Tools] - [Check Now].
3 Select [Start] after selecting required items in [Check disk options].
At startup, hold down    F8    when [Panasonic] boot screen disappears, and release your
finger when the Windows Advanced Option Menu is displayed.  Start the computer in
Safe Mode, and confirm the details of the error.
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No display after powering on

The power has not been
turned off, but after a cer-
tain period of time, there is
no display

When the battery pack is
used, the screen is darker
than when the AC adaptor
is connected
An afterimage appears (e.g.,
green, red, and blue dots
remain on the display) or
there are dots not display-
ing the correct colors

The external display no
longer displays properly

During simultaneous dis-
play, the screen of the exter-
nal display becomes disor-
dered

When an MPEG file is be-
ing played with Media
Player, the display destina-
tion cannot be switched us-
ing Fn   +   F3

When there is no display to an external display,
• Check your cable connection to the external display.
• Confirm your display is powered on.
• Check the settings for your external display.
The display destination may be set to the external display.
Try changing the display destination by pressing    Fn   +   F3   .
If you want to switch the display destination repeatedly by pressing    Fn   +   F3   , make
sure that the display destination has switched completely each time before pressing
  Fn   +   F3   again.
Has the computer been set to the power-saving mode?
To resume operation of your computer from the condition the power of the display is off
(for energy conservation purposes), press any key unrelated to the direct triggering of a
selection, like    Ctrl   .
To save power, your computer may have automatically entered the standby mode (power
indicator blinks green) or hibernation mode (power indicator turns off).  In such cases,
slide the power switch.
Press   Fn   +   F2    and adjust the brightness.  Note, however, that when the brightness
is increased, the battery running time will become shorter. Brightness can be set to sepa-
rate levels for when the AC adaptor is connected and when it is disconnected.

If an image is displayed for a prolonged period of time, an afterimage may appear.  This
is not a malfunction.  The afterimage will disappear when a different screen is displayed.
High-precision and advanced technologies are necessary in the production of color liquid
crystal displays (color LCDs).  Therefore, if 0.002% or less of the picture elements either
fail to light or remain constantly lit (that is, more than 99.998% of elements are function-
ing properly), no defect is considered to exist.
When an external display not compatible with the power saving mode is used with the
computer, the display may not function correctly when the computer enters the power
saving mode.  In such cases, turn off the power to the external display.
Try changing the display by pressing    Fn    +   F3   .
If you continue to experience problems, try changing the display in the following menu.

Windows XP
[Start] - [Control Panel] - [Other Control Panel Options] - [Intel(R)  Extreme Graphics] -
[Devices]

Windows 2000
[Start] - [Settings] - [Control Panel] - [Intel(R)  Extreme Graphics] - [Devices]
The display destination cannot be switched while an MPEG file is playing. Stop playing
the MPEG file before switching the display destination.

 Display

Windows cannot be shut
down or restarted

 Shutting Down
If a USB device is connected, try removing it.
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Dealing with Problems (Summary)

 Battery Indicator
The red indicator lights.

The red indicator blinks

The orange indicator blinks

The green indicator blinks

The battery indicator blinks
green and orange alternately

The battery level is very low (the charge is less than approx. 9% capacity).
Connect the AC adaptor. You can use the computer when the indicator light is orange. If you
do not have an AC adaptor, save your data and power off your computer. After replacing the
battery pack with a fully charged one, turn your computer on.
Quickly save your data and power off your computer. Remove the battery pack and discon-
nect the AC adaptor, then connect them again.
If the problem persists, contact Panasonic Technical Support.  Possible failure in the battery
pack or charging circuit.
Battery cannot be recharged temporarily because the internal temperature of the battery pack
is outside of the acceptable temperature range for recharging. Once the allowable range
requirement is satisfied, charging begins automatically. Your computer can be used normally
in this state.
In high temperature mode, the battery pack is discharging to a level of 80%* in normal
temperature mode. (   “Battery Power”)
Do not remove the battery pack while the battery indicator is blinking green.
* A level of 80% in normal temperature mode is displayed as [100%] in high temperature mode.

Warming up the system to prevent hard disk drive malfunctions at low temperature.  Leave
your computer as is. Once the allowable temperature range requirement is satisfied, your
computer will start automatically.

The Reference Manual is
not displayed

Is Acrobat Reader installed?
If Acrobat Reader is not installed, run [c:\util\reader\acroreader51_enu_full.exe] in [Start] -
[Run] to reinstall the program.  When installing the program, do not change the installation
destination folder.  If the destination folder is changed, the Reference Manual cannot be
opened from the [Start] menu.

 Reference Manual

 Touch Pad/Touchscreen (only for models with touchscreen)
If you are using an external mouse, ensure that the external mouse has been connected
correctly.
Restart the computer by using the keyboard (Press      ,   U   , and select [Restart] with
                   , then press    Enter   ).
If the computer does not respond to keyboard commands, read “No response”
(  page 29).
When the Microsoft® IntelliMouse™ Wheel mode or the original mode is set for the
touch pad, only scroll operations are possible for the right part or bottom part of the touch
pad.   In this case, cursor operations are possible by using the work surface excluding the
right part or bottom part.   When no mode is set, the entire surface of the touch pad can be
used for cursor operations.
Has the Setup Utility been used to set [Touch Pad] to [Enable]?
When external mouse drivers are installed (e.g., Intellimouse), the touch pad may not be
used.
Has the touch pad driver been properly installed?
As a result of the physical characteristics of the Touchscreen, sometimes the position of
the stylus does not match the position of the cursor on the screen.  This is not a malfunc-
tion.  Perform [Calibration] (  page 13).
Has the Setup Utility been used to set [Touchscreen] to [Enable]?
When mouse drivers are installed (i.e. IntelliMouse), the touchscreen is unable to be
used.
Has the touchscreen driver been properly installed?

The cursor cannot be con-
trolled properly

The cursor does not move in
scrolling area of the touch
pad

Unable to input using the
touch pad

Unable to point correctly
with the stylus included
with the computer
Unable to input by touching
the display
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Some applications may not
work properly

When switching to a different user with the Fast User Switching function, the following
problems may occur.
• Some applications may not work properly.
• Key combinations with the Fn key may not work.
• It may not be possible to set the settings of the display.
• The wireless LAN cannot be used.
• A serial mouse may not work.
In this case, log off all users, and try the operation once more. If the problem persists, restart
the computer.

 Fast User Switching function Windows XP

 Others
Press   Ctrl   +   Shift   +   Esc   to open Task Manager and close the software application
which is not responding.
After shutting down by sliding the power switch for more than four seconds, sliding the
power switch to power on and open the application again.
If the program no longer works normally, delete the program using the following menu.
Then reinstall the program.

Windows XP : [Start] - [Control Panel] - [Add or Remove Programs]
Windows 2000 : [Start] - [Settings] - [Control Panel] - [Add/Remove Programs]

No response
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Reinstalling Software

Before Reinstallation

Preparing
• Product Recovery CD-ROM (included)
• Panasonic CD drive (optional: Confirm the latest information on optional products in catalogs, etc.)

Reinstalling

Important
Before the reinstallation procedure, remove all peripherals (except for the CD drive).
Be sure the AC adaptor is connected until the reinstallation procedure is completed.

When reinstallation procedure is performed, the contents of the hard disk will be erased.  Be sure to back up any critical data on
your hard disk to another media or to an external hard disk before running the reinstallation procedure.
The reinstallation procedure will return the computer to its original condition.
Even if a hard disk backup area has been created, this backup area will be erased, and all the backed up data will be lost.
(This is not the case when Windows is reinstalled in the first partition.)
• If you have created partitions for data, the data may be erased or become corrupt as a result of the reinstallation procedure.

1 Turn off the computer and insert the CD drive into the
multimedia pocket. (   “Multimedia Pocket”)

2 Turn on the computer, and press   F2   while [Panasonic]
boot screen is displayed.
The Setup Utility will start up.
If the password has been set, enter the Supervisor Pass-
word.

3 Write down all of the contents of the Setup Utility and
then press   F9   .
At the confirmation message, select [Yes] and press
  Enter   .

4 Select [Boot] menu, then select [CD Drive] and press
  F6    until [CD Drive] is at the top of the [Boot] menu.

5 Place the disc number one of the recovery CDs into the CD
drive.

6 Press   F10   .
At the confirmation message, select [Yes] and press
   Enter   . The computer will restart.
<When the hard disk backup function has been enabled>
When the message [The Backup function has been en-
abled. If [Recovery] or [Erase HDD] is executed, the
Backup function will be disabled, and your Backup data
will be lost.] appears, press     Y   .
This screen should appear.

7 Press [1.[Recovery]].
The License Agreement screen should appear.

8 Press [1. Yes, I agree to the provisions above and wish to
continue!].

9 Make a selection from the menu.
When selecting [2], enter the basic partition size for
the operating system installation and press
   Enter   .
(The data partition size is the remainder after sub-
tracting the basic partition size.)
To select [3], the initial partition size must be 6 GB
or more of the hard disk size. Reinstallation cannot
be performed with a small partition size.

<When the hard disk backup function has been enabled>
If you select [1] or [2], the message [The Backup func-
tion has been enabled. If [Recovery] is executed, the
Backup function will be disabled, and your Backup
data will be lost.] appears.  In this case, press    Y   .
However, when [2] is selected, the hard disk backup
function cannot be re-enabled because the hard disk
has been divided into partitions.

---------------------------------------------------------------------
Select a number
---------------------------------------------------------------------
1. [ Recovery ] Reinstall Windows.
2. [ Erase HDD ] Erase the whole data on HDD for security.
3. [ Backup ] Enable the Backup function.

0. [ Cancel ] Cancel.---------------------------------------------------------------------

Windows 2000

Windows XP
This screen should appear.

---------------------------------------------------------------------
Select a number
---------------------------------------------------------------------

Reinstalling : Windows(R) XP Professional

1. Reinstall Windows to the whole HDD to factory default.
2. Make two partitions, for the operating system and data. And reinstall

Windows to the operating system partition.
(All existing partitions on HDD will be lost.)

3. Reinstall Windows to the first partition.

0. Cancel---------------------------------------------------------------------

---------------------------------------------------------------------
Select a number
---------------------------------------------------------------------

Reinstalling : Windows(R) 2000 Professional

1. Reinstall Windows to the whole HDD to factory default.
2. Make two partitions, for the operating system and data. And reinstall

Windows to the operating system partition.
(All existing partitions on HDD will be lost.)

3. Reinstall Windows to the first partition.

0. Cancel---------------------------------------------------------------------
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11 After the reinstallation procedure completes, this
screen should appear.
Remove the recovery CD.

Do not interrupt the reinstallation procedure be-
fore completion, for example by turning off the
computer or pressing Ctrl   +   Alt   +   Del  , as
this may prevent Windows from starting up, or may
cause data to be lost so that the reinstallation pro-
cedure  cannot be executed.
When a message appears instructing you to insert
the next CD, insert the recovery CD showing the
next number in the sequence, and then select [OK].
If the message [The media does not contain the
correct file] appears, select [OK]. A message will
appear instructing you to insert the next CD.
Confirm that the proper recovery CD has been in-
serted by opening the cover of the CD drive and
then close the cover, then select [OK].

CAUTION

----------------------------------------------------------------------
[Recovery] is complete.
Windows(R) XP Professional install wizard will start after reboot.
Please Remove the Product Recovery CD-ROM, and press
Ctrl + Alt + Del (Delete) to reboot.----------------------------------------------------------------------

Windows XP

Windows 2000
----------------------------------------------------------------------
[Recovery] is complete.
Windows(R) 2000 Professional install wizard will start after reboot.
Please Remove the Product Recovery CD-ROM, and press
Ctrl + Alt + Del (Delete) to reboot.----------------------------------------------------------------------

10 At the confirmation message , press   Y   .
The operation of reinstallation for the hard disk starts
automatically. (The operations take about an hour.)

12 Restart the computer by pressing   Ctrl   +   Alt   +
  Del    and press   F2   while [Panasonic] boot screen is
displayed.
The Setup Utility will start up.
If the password has been set, enter the Supervisor Pass-
word.

13 Press   F9   .
At the confirmation message, select [Yes] and press
   Enter   .  (The Setup Utility settings will return to their
default values.  Even the security settings with the ex-
ception of the password(s) will return to their default
values.)

14 Press   F10   .
At the confirmation message, select [Yes] and press
   Enter   .

15 Perform the setup procedure for Windows by following
the instructions on the screen (  page 12-14).

16 Run the Setup Utility and change the settings where nec-
essary.

<Changing the drive letter>
You can change the drive letter for the CD drive or hard disk
drive by the following steps.

Drive letters can only be changed when two or more parti-
tions have been created on the hard disk drive. The name
of the C: drive cannot be changed.
We recommend that you make these changes before in-
stalling applications.

Windows XP
1 Select [Start] - [Control Panel] - [Performance and Main-

tenance] - [Administrative Tools] - [Computer Manage-
ment].

2 Select [Disk Management] from [Storage].
3 Right click on the partition of the hard disk or the name of

the CD drive and select [Change Drive Letter and Paths...].
4 Select [Change].
5 Select [Assign the following drive letter] and select the

new drive letter, and then select [OK].
6 At the confirmation message, select [Yes].

Windows 2000
1 Select [Start] - [Settings] - [Control Panel] - [Administra-

tive Tools] - [Computer Management].
2 Select [Disk Management] from [Storage].
3 Right click on the partition of the hard disk or the name of

the CD drive and select [Change Drive Letter and Path...].
4 Select [Edit].
5 Select [Assign a drive letter] and select the new drive let-

ter, and then select [OK].
6 At the confirmation message, select [Yes].
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LIMITED USE LICENSE AGREEMENT
THE SOFTWARE PROGRAM(S) (“PROGRAMS”) FURNISHED WITH THIS PANASONIC® PRODUCT (“PRODUCT”)
ARE LICENSED ONLY TO THE END-USER (“YOU”), AND MAY BE USED BY YOU ONLY IN ACCORDANCE WITH
THE LICENSE TERMS DESCRIBED BELOW. YOUR USE OF THE PROGRAMS SHALL BE CONCLUSIVELY DEEMED
TO CONSTITUTE YOUR ACCEPTANCE OF THE TERMS OF THIS LICENSE.
Matsushita Electric Industrial Co., Ltd. (“MEI”) has developed or otherwise obtained the Programs and hereby licenses
their use to you. You assume sole responsibility for the selection of the Product (including the associated Programs) to
achieve your intended results, and for the installation, use and results obtained therefrom.

LICENSE
A. MEI hereby grants you a personal, non-transferable and non-exclusive right and license to use the Programs in

accordance with the terms and conditions stated in this Agreement. You acknowledge that you are receiving only
a LIMITED LICENSE TO USE  the Programs and related documentation and that you shall obtain no title,
ownership nor any other rights in or to the Programs and related documentation nor in or to the algorithms,
concepts, designs and ideas represented by or incorporated in the Programs and related documentation, all of
which title, ownership and rights shall remain with MEI or its suppliers.

B. You may use the Programs only on the single Product which was accompanied by the Programs.

C. You and your employees and agents are required to protect the confidentiality of the Programs. You may not
distribute or otherwise make the Programs or related documentation available to any third party, by time-sharing
or otherwise, without the prior written consent of MEI.

D. You may not copy or reproduce, or permit to be copied or  reproduced, the Programs or related documentation
for any purpose, except that you may make one (1) copy of the Programs for backup purposes only in support of
your use of the Programs on the single Product which was accompanied by the Programs. You shall not modify,
or attempt to modify, the Programs.

E. You may transfer the Programs and license them to another party only in connection with your transfer of the
single Product which was accompanied by the Programs to such other party. At the time of such a transfer, you
must also transfer all copies, whether in printed or machine readable form, of every Program, and the related
documentation, to the same party or destroy any such copies not so transferred.

F. You may not remove any copyright, trademark or other notice or product identification from the Programs and
you must reproduce and include any such notice or product identification on any copy of any Program.

YOU MAY NOT REVERSE ASSEMBLE, REVERSE COMPILE, OR MECHANICALLY OR ELECTRONICALLY TRACE
THE PROGRAMS, OR ANY COPY THEREOF, IN WHOLE OR IN PART.
YOU MAY NOT USE, COPY, MODIFY, ALTER, OR TRANSFER THE PROGRAMS OR ANY COPY THEREOF, IN
WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THE LICENSE.
IF YOU TRANSFER POSSESSION OF ANY COPY OF ANY PROGRAM TO ANOTHER PARTY, EXCEPT AS PERMIT-
TED IN PARAGRAPH E ABOVE, YOUR LICENSE IS AUTOMATICALLY TERMINATED.

TERM
This license is effective only for so long as you own or lease the Product, unless earlier terminated. You may terminate
this license at any time by destroying, at your expense, the Programs and related documentation together with all
copies thereof in any form. This license will also terminate effective immediately upon occurrence of the conditions
therefor set forth elsewhere in this Agreement, or if you fail to comply with any term or condition contained herein. Upon
any such termination, you agree to destroy, at your expense, the Programs and related documentation together with all
copies thereof in any form.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND
BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND EXCLUSIVE STATE-
MENT OF THE AGREEMENT BETWEEN US, WHICH SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT,
ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN US, RELATING TO THE SUBJECT MAT-
TER OF THIS AGREEMENT.

About Intel® software products
The enclosed software products and documentation were developed at private expense, and are provided with “RESTRICTED
RIGHTS.” Use, duplication or disclosure by the government is subject to restrictions as set forth in FAR 52.227-14 and
DFARS 252.227-7013 et. seq. or its successor. The use of this product by the government constitutes acknowledgment of
Intel's proprietary rights in the product.
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Contrat de licence d’usage limité
Le(s) logiciel(s) (les “Logiciels”) fournis avec ce produit Panasonic® (le “Produit”) sont exclusivement concédés en
licence à l’utilisateur ultime (“vous”), et ils ne peuvent être utilisés que conformément aux clauses contractuelles ci-
dessous. En utilisant les logiciels, vous vous engagez de manière définitive à respecter les termes, clauses et condi-
tions des présentes.

Matsushita Electric Industrial Co., Ltd. (“MEI”) a mis au point ou obtenu les Logiciels et vous en concède l’utilisation par
les présentes. Vous assumez l’entière responsabilité du choix de ce Produit (y compris des Logiciels associés) pour
obtenir les résultats escomptés, ainsi que de l’installation, de l’utilisation et des résultats obtenus.

Licence

A. MEI vous octroie par les présentes le droit et la licence personnels, non cessibles et non exclusifs d’utiliser les
Logiciels conformément aux termes, clauses et conditions de ce contrat. Vous reconnaissez ne recevoir qu’un
droit limité d’utiliser les Logiciels et la documentation les accompagnant et vous vous engagez à n’obtenir aucun
droit de titre, propriété ni aucun autre droit vis-à-vis des Logiciels et de la documentation les accompagnant ni
vis-à-vis des algorithmes, concepts, dessins, configurations et idées représentés par ou incorporés dans les
Logiciels et la documentation les accompagnant, dont les titres, la propriété et les droits resteront tous à MEI ou
à leurs propriétaires.

B. Vous ne pouvez utiliser les Logiciels que sur le Produit unique qui est accompagné par les Logiciels.

C. Vous et vos employés ou agents êtes requis de protéger la confidentialité des Logiciels. Vous ne pouvez ni
distribuer ni mettre les Logiciels et la documentation les accompagnant à la disposition d’un tiers, par partage
de temps ou de quelque autre manière que ce soit, sans l’autorisation écrite préalable de MEI.

D. Vous ne pouvez ni copier ni reproduire ni permettre la copie ni la reproduction des Logiciels ni de la documen-
tation les accompagnant pour quelque fin que ce soit, à l’exception d’une (1) copie des Logiciels à des fins de
sauvegarde uniquement pour soutenir votre utilisation des Logiciels sur le Produit unique qui est accompagné
par les Logiciels. Vous ne pouvez ni modifier ni tenter de modifier les Logiciels.

E. Vous ne pouvez céder les Logiciels et en octroyer la licence à une autre partie qu’en rapport avec votre cession
du Produit unique qui est accompagné par les Logiciels à cette autre partie. Au moment de cette cession, vous
devez céder également toutes les copies, que ce soit sous forme imprimée ou lisible par la machine, de tous les
Logiciels ainsi que de la documentation les accompagnant, à la même partie ou détruire les copies non cédées.

F. Vous ne pouvez retirer aucune marque de droits d’auteur, marque de commerce ou autre ni aucune identifica-
tion de produit des Logiciels et vous devez reproduire et inclure toutes ces notices ou identifications de produit
sur toutes les copies des Logiciels.

Vous ne pouvez assembler en sens inverse, compiler en sens inverse ni retracer les Logiciels ni aucune de leurs
copies, de façon électronique ou mécanique, en tout ou en partie.

Vous ne pouvez utiliser, copier, modifier, altérer ni céder les Logiciels ni aucune de leurs copies, en tout ou en partie,
à l’exception de ce qui est expressément stipulé dans ce contrat.

Si vous cédez la possession de toute copie ou de tout Logiciel à une autre partie, à l’exception de ce qui est autorisé
au paragraphe E ci-dessus, votre licence est automatiquement résiliée.

Termes, clauses et conditions

Cette licence n’est effective que pour la durée de possession ou de crédit-bail du Produit, à moins d’une résiliation
antérieure. Vous pouvez résilier cette licence à tout moment en détruisant, à vos frais, les Logiciels et la documentation
les accompagnant avec toutes leurs copies, sous quelque forme que ce soit. Cette licence sera également résiliée,
avec application immédiate, si les conditions de résiliation définies ailleurs dans ce contrat se sont réalisées ou si vous
ne respectez pas les termes, clauses et conditions qui y sont contenues. Au moment de la résiliation, vous acceptez de
détruire, à vos frais, les Logiciels et la documentation les accompagnant avec toutes leurs copies, sous quelque forme
que ce soit.

Vous reconnaissez avoir lu ce contrat, en avoir compris toute la substance et avoir accepté de respecter ses termes,
clauses et conditions. Vous reconnaissez en outre qu’ils sont la description complète et exclusive du contrat conclu
entre nous, contrat qui remplace et annule toute proposition ou contrat précédent, écrit ou oral, et toute autre commu-
nication entre nous, relativement à l’objet du présent contrat.
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Hard Disk Backup Function
The hard disk backup function creates a backup area (storage area) on the hard disk. This area is to back up (store) hard disk
contents or restore backed up contents to their original locations.
By backing up the data on your hard disk to a backup area, you can protect your data from loss or damage resulting from opera-
tional errors or other factors.  Also, you can back up or restore hard disk contents using this computer alone, without having to use
other media or peripheral devices.
At the time of purchase, the hard disk backup function is disabled.  If you follow the procedure below to create a backup area, the
hard disk backup function will be enabled, and you will be able to back up your data.  Note, that once the backup function has been
enabled, you will have to perform the reinstallation procedure to disable it again (  page 30).

Disconnect or remove all peripheral devices (except for the CD drive), as the backup area may
not be created properly while these devices are connected.
Be sure the AC adaptor is connected to the computer.
A backup area cannot be created if the hard disk is already divided into several partitions.  Return
the computer to its condition at the time of purchase (one partition only), and create the backup
area.
To divide the partition, make the selection when the backup area is created (  page 33 step 8).
If the partition configuration is changed (partitions created, size changed, etc.) after the backup
area has been created, it will no longer be possible to execute the backup function.  To change the
configuration, it is necessary to return the computer to its condition at the time of purchase, and
then create the backup area again.
The hard disk backup function will only work for the internal hard disk. This function does not
work with an external hard disk.
Backup and restore functions will not operate if the hard disk has been damaged.
Do not use the NTFS file system compression function, as this may result in insufficient capacity
of the backup area.
If the hard disk malfunction occurs, it will be impossible to read the data stored hard disk.  We
recommend that you also back up important data to a location other than the hard disk (an external
hard disk or other media).
Execute a disk error check using the following procedure.
1 Display the [Local Disk(C:) properties].

Windows XP
Select [Local Disk(C:)] with the right button in [Start] - [My Computer], and select [Properties].

Windows 2000
Select [Local Disk(C:)] with the right button in [My Computer], and select [Properties].

2 Select [Check Now] from [Tools].
3 In [Check Disk], select [Start] without adding a check mark beside any of the items.

If a message is displayed indicating that there is an error in the disk, display [Check Disk], and
add a check mark for [Automatically fix file system errors] and [Scan for and attempt recov-
ery of bad sectors], select [Start], and check for disk errors again.

The hard disk backup function does not accommodate dynamic disks.  Do not convert the hard
disk to a dynamic disk.

The hard disk backup function cannot back up or restore data properly if there is a problem with the hard disk when the data is
backed up or restored.  Note that if an error occurs while data is being restored, whether as a result of an unexpected malfunc-
tion, incorrect operation, or other reason, the data in the hard disk (data before restoration) may be lost.
Matsushita Electric Industrial Co., Ltd. will bear no responsibility for any damages suffered by the user (including loss of data)
as a result of the use of this function.

Before Using a Hard Disk Backup Function

Preparing
Product Recovery CD-ROM (included)
Panasonic CD drive (optional: Confirm the latest information on optional products in catalogs,
etc.)

(To next page)
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1 Turn off the computer and insert the CD drive into the multimedia pocket. (   “Multi-
media Pocket”)

2 Turn the computer on, and press   F2   while [Panasonic] boot screen is displayed.
The Setup Utility will then start.
If a password has been set, enter the Supervisor Password. You cannot register [Boot] menu
with a User Password.

3 Select [Boot] menu, then select [CD Drive] and press    F6    until [CD Drive] is at the top of the
[Boot] menu.

4 Place disk number one of the recovery CDs into the CD drive.
5 Press    F10  .

At the confirmation message, select [Yes] and press   Enter  .
The computer will restart. If [Input the password] is displayed during the following procedures,
input the Supervisor Password or the User Password.
This screen should appear.

6 Press   3    to execute [3.Backup].

Regarding backup area
• Requires availability of at least half of the entire hard disk.  Without sufficient space

available, the backup area cannot be created.
• When the backup area is created, the usable hard disk capacity will be reduced to less

than half.
• The backup area cannot be accessed from Windows.  For this reason, backed up data

cannot be copied to CD-R or other removable disk media.
• When the hard disk backup function is executed, data in the backup area will be

overwritten.  If newly created or edited data is backed up later, data stored previously
in the backup area will be lost.

NOTE

Create a Backup Area

When dividing the hard disk into partitions
Do not execute [1. Recovery] to divide the hard disk into partitions.  The hard disk
backup function cannot be enabled after the hard disk has been partitioned.  Use proce-
dure 8 to devide the hard disk.

CAUTION

The usable hard disk area

[At the time of purchase] [After the backup area is created]

The backup area

Cannot be accessed
from Windows.

Can be accessed from
Windows (One partition).

7 At the confirmation message, press   Y   .
8 Select how to divide the hard disk from the menu.

<To create a backup area and enable the backup function without dividing the hard disk>
 Select [1].

---------------------------------------------------------------------
Select a number
---------------------------------------------------------------------
1. [ Recovery ] Reinstall Windows.
2. [ Erase HDD ] Erase the whole data on HDD for security.
3. [ Backup ] Enable the Backup function.

0. [ Cancel ] Cancel.---------------------------------------------------------------------
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Hard Disk Backup Function

9 When the confirmation message is displayed, press    Y   .
The backup area is then created.

10 When the message [You must reboot in order to enable the Backup function] appears, remove
the recovery CD, and press any key to restart the computer. The computer is restarted, then the
backup process will begin.

11 When the message [[Backup] is complete] appears, press   Ctrl   +   Alt   +   Del    to restart the
computer.

Do not press   Ctrl   +   Alt   +   Del   until the message is displayed.

CAUTION

The [Boot] menu in the setup utility is set to start up from the CD drive. Change this setting
if necessary.
The next time the backup or restore functions are executed, follow the procedure for [Backing
Up and Restoring Data] (  below).

NOTE

1 Turn the computer on, and press   F2   while [Panasonic] boot screen is displayed.
The Setup Utility will start up.
If a password has been set, enter the Supervisor Password or the User Password.

2 Select     and     to move to the [Exit] menu, then select    and    to select [Hard Disk
Backup / Restore] and press  Enter   .
At the confirmation message, select    Y   , and press   Enter   .

Backing Up and Restoring Data

Before executing the backup function, execute a disk error check (  page 34).
Do not interrupt the backup or restore functions before completion, for example by turning
off the power or pressing   Ctrl   +   Alt   +   Del  , as this may prevent Windows from
starting up, or may cause data to be lost so that the backup and restore functions cannot be
executed.

CAUTION

12 A message will appear advising that a new device has been installed and that the computer
must be rebooted to enable the settings.  Select [Yes] to restart the computer.

<To create a backup area and divide hard disk into two partitions, for OS and data>
Select [2], enter the partition size (GB), and press   Enter   .
• You can cancel this operation by pressing    0   .
• The data partition size will be the maximum settable size less the number entered above.
The maximum settable size will differ depending on models.

The usable hard disk area

[At the time of purchase] [After the backup area is created]

The backup area

Cannot be accessed
from Windows.

Can be accessed from
Windows (Two partitions).
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To disable the hard disk backup function
Perform the reinstallation procedure.  All data in the backup area and the hard disk will be
erased.
Conduct steps 1-7 for [Reinstalling Software]  (  page 30). Select [1] or [2] to execute the
reinstallation at the screen for executing the reinstallation.
• When [1] is selected, the hard disk backup function can be disabled.
• When [2] is selected, the hard disk backup function can be disabled, but in this case, because

the hard disk has been divided into partitions, the hard disk backup function cannot be
re-enabled  (  page 23).

• When [3] is selected, the hard disk backup function cannot be disabled.

CAUTION
When the hard disk backup function has been enabled, even if a commercial data erasing
utility or similar software is used to erase all data from user-accessible area, the backed up
data will not be erased.  You can use the hard disk data erase utility included in this com-
puter (  page 36) to erase all data on the hard disk, including backed up data. Use this
hard disk data erase utility before disposing of or transferring ownership of this computer.
Occasionally, the message [#1805 cannot write image file] will be displayed, and the backup
function will be interrupted.  If this error occurs, execute the backup function again.  After
this, if the backup function is completed properly, then there is no problem in the hard disk.

4 When the message [[Backup] is complete] or [[Restore] is complete] is displayed, press
 Ctrl      +  Alt  +  Del   to restart the computer.
•  If the backup or restore process was interrupted before completion, for example if the power

was turned off, execute the process again.
•  When a new device is installed and a message appears advising that the computer must be

restarted to enable the settings, select [Yes] to restart the computer.

3 Select the operation to be executed from the menu.
<To back up hard disk contents to the backup area>
1  Press  1  to execute [1. [Backup]].

(When dividing the hard disk into two partitions, select the backup method at next screen.)
2 At the confirmation message, press   Y   .

The backup process will begin.
<To restore backed up contents to the hard disk>
1  Press  2  to execute [2. [Restore]].

(When data is backed up in two partitions, select the restore method at next screen.)
2 At the confirmation message, press   Y   .

The restore process will begin.

The time required to complete the backup or restore process differs depending on the data
volume.

NOTE
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Hard Disk Data Erase Utility
This computer is equipped with a utility for erasing hard disk data.
When disposing of or transferring ownership of this device, erase all data on the hard disk in order to prevent the theft of hard disk
data following the steps below.

The hard disk data erase utility erases data using an “overwriting” method, but there is a possibility that due to malfunctions or
other operational errors, data may not be completely erased. There are also specialized devices that may be able to read data
that has been erased using this method. If you need to erase highly confidential data, we recommend that you contact a
company that specializes in this process. Matsushita Electric Industrial Co., Ltd. will bear no responsibility for losses or
damages suffered as a result of the use of this utility.

Preparing

Procedure

Product Recovery CD-ROM (included)
Panasonic CD drive (optional: Confirm the latest information on optional products in catalogs, etc.)

1 Turn off the computer.

2 Insert the CD drive into the multimedia pocket. (
 “Multimedia Pocket”)

3 Turn the computer on, and press   F2   while [Panasonic]
boot screen is displayed.
The Setup Utility will start up.
If the password has been set, enter the Supervisor
Password.

4 Select [Boot] menu, then select [CD Drive] and press   F6
until [CD Drive] is at the top of [Boot] menu.

5 Place the disc number one of the recovery CDs into the
CD drive.

6 Press    F10   .
At the confirmation message, select [Yes] and press
   Enter   .  The computer will restart.
<When the hard disk backup function has been enabled>
When the message [The Backup function has been en-
abled. If [Recovery] or [Erase HDD] is executed, the
Backup function will be disabled, and your Backup data
will be lost.] appears, press Y   .
This screen should appear.

NOTE
Be sure the AC adaptor is connected until the procedure is completed.
This utility can only be used for internal hard disk.  It cannot be used to erase data from external hard disks.
This utility cannot erase data from damaged disk.
This utility cannot erase data for specific partitions.
After executing this utility, the computer cannot be booted from the hard disk.

7 Press   2    to execute [2. [Erase HDD]].
<When the hard disk backup function has been enabled>
When the message [The Backup function has been en-
abled. If [Erase HDD] is executed, the Backup function
will be disabled, and your Backup data will be lost.] ap-
pears, press Y   .

-------------------------------------------------------------------
Select a number
-------------------------------------------------------------------
1. [ Recovery ] Reinstall Windows.
2. [ Erase HDD ] Erase the whole data on HDD for security.
3. [ Backup ] Enable the Backup function.

0. [ Cancel ] Cancel.-------------------------------------------------------------------

8 When the message [Computer must be rebooted in order
to execute [Erase HDD]] appears, press R   .

9 At the confirmation message, press   Y   .

10 When [<<<Start Menu>>>] is displayed, press   Enter   .

11 The approximate time required for erasing data will be
displayed.
Press   Space   .

12 At the confirmation message, press   Enter   . The
operation of erasing the hard disk starts.
(If necessary, the “hard disk data erase” operation can be
cancelled after it has begun by pressing    Ctrl   +   C   .
If the operation is cancelled before being completed, a
part of data will not be erased.)

13 After the operation is complete:
Under normal conditions, the message [Hard disk data has
been deleted.] will be displayed.
If a problem occurred during the operation, an error mes-
sage will be displayed.

14 Remove the recovery CD, then turn off the computer by
sliding the power switch.
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Specifications

Model No.

CPU
L2 (Second) Cache Memory
Memory
(Expandable to)
Video Memory
LCD Type

Displayed Colors*2

External Display

Hard Disk Drive
Keyboard
Floppy Disk Drive
Slots PC Card Slots

Allowable current
(total for two slots)

RAM Module Slot*5

Interface Parallel Port
External Display Port
Serial Port
Microphone Jack*6

Headphone Jack
External Keyboard/Mouse Port
Expansion Bus Connector
USB Port
Modem
LAN
Wireless LAN

Pointing Device

Sound

*1 A segment of the main memory is allotted automatically depending on the computer’s operating status.  The size of the Video Memory
cannot be set by the user.

*2 A 16M color display is achieved by using the dithering function. Windows XP : 256 color depth and the resolution of 640x480 are not supported.
*3 Maximum resolution depends on the specifications of the external display. Windows XP : 256 color depth and the resolution of 640x480 are not supported.
*4 1GB = 109 bytes
*5 Only a RAM card designed for PC2100 can be added.
*6 Use only a monaural condenser microphone.
*7 The settings for the K56flex modem need to be changed according to the AT command.

Main Specifications
CF-29CTKGZKM CF-29C3KGZKM
CF-29CTKGZDM CF-29C3KGZDM
Intel® Pentium® M Processor 1.2 GHz LV
1 MB
256 MB
(768 MB Max.)
UMA (64 MB Max.)*1

13.3 XGA type (TFT) with Touchscreen 13.3 XGA type (TFT)

256/65536/16M colors (640 x 480 dots/800 x 600 dots/1024 x 768 dots/1280 x
1024 dots/1600 x 1200 dots)*3

40 GB*4

87 keys
720 KB/1.44 MB (two-mode)
Two Type I or Type II, or one Type III
3.3 V: 400 mA
5 V: 400 mA
200 pin, 2.5 V, SO-DIMM, DDR SDRAM, PC2100 Compliant
Dsub 25-pin female
Mini Dsub 15-pin female
Dsub 9-pin male
Miniature jack, 3.5 DIA
Miniature jack, 3.5 DIA, Impedance 32 Ω, Output Power 4 mW x 2
Mini DIN 6-pin female
Dedicated 80-pin female
4-pin, USB 2.0
RJ-11 jack, Data: 56 kbps (V.92 & K56flex*7)   FAX:14.4 kbps
RJ-45 jack, IEEE 802.3 10Base-T, IEEE 802.3u 100Base-TX
IEEE 802.11b compliant Frequency 2.4 GHz band

WAVE and MIDI playback, Monaural Speaker (built in)

256/65536/16M colors (640 x 480 dots/
800 x 600 dots/1024 x 768 dots)

256/65536/16M colors (640 x 480 dots/
800 x 600 dots/1024 x 768 dots)

Touch Pad, Touchscreen (Anti-Reflection, Sty-
lus (included) touch capable)

Touch Pad
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Model No.
Battery Pack

Operating Time*8

Charging Time*8 Power On

Power Off

Clock Battery
AC Adaptor*9 Input

Output
Power Consumption*10

Environment In use Temperature
Humidity

Not in use Temperature
Humidity

Physical Dimensions (W x H x D)

Weight (including the carrying handle)

CF-29CTKGZDM/CF-29CRKGZDM
CF-29C3KGZDM
Microsoft® Windows® 2000 Professional
with Service Pack3
(NTFS File System)
Setup Utility
DMI Viewer
Adobe® Acrobat® Reader
Panasonic Hand Writing
PC Information Viewer
Hard Disk Backup Utility*12

Hard Disk Data Erase Utility*12

Intel® PROSet
WLAN Security Client
Intel® SpeedStep™ technology Applet

Software
Model No.

Operating System

Utility Programs

CF-29CTKGZKM/CF-29CTKGZDM CF-29C3KGZKM/CF-29C3KGZDM
Li-ion 11.1 V, 6.6 Ah
Main battery: Approx. 3.5 hours - 5.5 hours
Main battery + Second battery: Approx. 6.5 hours - 10 hours
Main battery: Approx. 5.5 hours
Main battery + Second battery: Approx. 9.5 hours
Main battery: Approx. 3 hours
Main battery + Second battery: Approx. 5.5 hours
Coin type lithium battery 3.0 V
100 V - 240 V AC, 50 Hz/60 Hz
15.6 V DC, 5.0 A
Approx. 35 W*11 / Approx. 55 W (maximum when recharging in the ON state)
5 °C to 35°C  {41 °F to 95 °F}
30% to 80% RH  (No condensation)
-20 °C to 60 °C  {-4 °F to 140 °F}
30% to 90% RH  (No condensation)
302 mm x 63.5 mm(at the rear)/65.5 mm(at the front) x 275 mm
{11.9 " x 2.5 "/2.6 " x 10.8 "} (excluding protrusion)
Approx. 4.2 kg {Approx. 9.3 lb.} Approx. 4.1 kg {Approx. 9.0 lb.}

Main Specifications

*8 Varies depending on the usage conditions, CPU speed, etc.
*9 The AC adaptor is compatible with power sources up to 240 V AC adaptor. The computer is supplied with a 125 V AC compatible AC cord.
*10 Approx. 0.9 W when the battery pack is fully charged (or not being charged) and the computer is off.
*11 Rated power consumption.

CF-29CTKGZKM/CF-29CRKGZKM
CF-29C3KGZKM
Microsoft® Windows® XP Professional
with Service Pack1
(NTFS File System)
Setup Utility
DMI Viewer
Adobe® Acrobat® Reader
Panasonic Hand Writing
PC Information Viewer
Hard Disk Backup Utility*12

Hard Disk Data Erase Utility*12

Intel PROSet
WLAN Security Client

*12 The Product Recovery CD-ROM is required.

Specifications
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LIMITED WARRANTY

PANASONIC PERSONAL COMPUTER AND PERIPHERALS LIMITED WARRANTY

Panasonic Computer Solutions Company (referred to as “Panasonic”) will repair this product (other than software, which is covered by a separate
warranty) with new or rebuilt parts, free of charge in the U.S.A. for three (3) years from the date of original purchase in the event of a defect in materials
or workmanship. This warranty includes the AC adaptor but excludes the batteries and all other options and accessories which are covered for a
period of one (1) year from the date of purchase.

This warranty is extended solely to the original purchaser. A purchase receipt or other proof of date of original purchase will be required before
warranty performance is rendered.

This warranty only covers failures due to defects in materials or workmanship which occur during normal use. It does not cover damage which occurs
in shipment or failures which are caused by products not supplied by Panasonic, or failures which result from alteration, accident, misuse, introduction
of liquid or other foreign matter into the unit, abuse, neglect, installation, maladjustment of consumer controls, improper maintenance, modification or
service by anyone other than a Factory Service Center or authorized Panasonic Service Dealer, or damage that is attributable to acts of God.

Limits and Exclusions:
There are no other express warranties except as listed below.

PANASONIC SHALL NOT BE LIABLE FOR LOSS OF DATA OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE
USE OF THIS PRODUCT, OR ARISING OUT OF ANY BREACH OF THIS WARRANTY. ALL EXPRESS AND IMPLIED WARRANTIES, INCLUDING
THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED TO THE APPLICABLE WARRANTY
PERIOD SET FORTH ABOVE. Some states do not allow the exclusion or limitation of incidental or consequential damages, or limitations on how long
an implied warranty lasts, so the above limitations or exclusions may not apply to you.

This limited warranty gives you specific legal rights, and you may also have other rights which vary from state to state. If a problem with your product
develops during or after the warranty period, you may contact our representatives at 1-800-LAPTOP5. If the problem is not handled to your satisfac-
tion, then write to the Consumer Affairs Division at the address indicated below.

SOFTWARE LIMITED WARRANTY

Panasonic Computer Solutions Company (referred to as “Panasonic”) warrants to you only that the disk(s) or other media on which the Programs are
furnished will be free from defects in materials and workmanship under normal use for a period of sixty (60) days from the date of delivery thereof to
you, as evidenced by your purchase receipt.

This is the only warranty Panasonic makes to you. Panasonic does not warrant that the functions contained in the Programs will meet your require-
ments or that the operation of the Programs will be uninterrupted or error free.
Panasonic’s entire liability, and your exclusive remedy under this warranty shall be limited to the replacement, in the United States, of any defective
disk or other media which is returned to Panasonic’s Authorized Service Center, together with a copy of the purchase receipt, within the aforesaid
warranty period.

Anything in the foregoing to the contrary notwithstanding, Panasonic shall have no obligation for any defects in the disk(s) or other media on which the
Programs are furnished resulting from your storage thereof, or for defects that have been caused by operation of the disk(s) or other media otherwise
than on the Product or in environmental conditions other than those specified by Panasonic by alteration, accident, misuse, abuse, neglect, mishan-
dling, misapplication, installation, maladjustment of consumer controls, improper maintenance, modification of damage that is attributable to acts of
God. In addition, Panasonic shall have no obligation for any defects in the disk(s) or other media if you have modified, or attempted to modify any
Program.

DURATION OF IMPLIED WARRANTIES, IF ANY, IS LIMITED TO SIXTY (60) DAYS.

PANASONIC ASSUMES NO RISK OF AND SHALL NOT IN ANY CASE BE LIABLE FOR ANY DAMAGES, INCLUDING, WITHOUT LIMITATION,
ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE DAMAGES ARISING FROM BREACH OF WARRANTY OR CONTRACT, NEGLI-
GENCE OR ANY OTHER LEGAL THEORY, INCLUDING, WITHOUT LIMITATION LOSS OF GOODWILL, PROFITS OR REVENUE, LOSS OF USE
OF THE PROGRAMS OR PRODUCTS OR ANY ASSOCIATED EQUIPMENT, COST OF CAPITAL, COST OF ANY SUBSTITUTE EQUIPMENT,
FACILITIES, SERVICES, DOWNTIME COSTS, OR CLAIMS OF ANY PARTY DEALING WITH YOU FOR SUCH DAMAGES.

Some states do not allow the exclusion or limitation of incidental or consequential damages, or limitations on how long an implied warranty lasts, so
the above limitations or exclusions may not apply to you.

This limited warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

This Limited Warranty will be governed by the laws the State of New York, without regard to its conflict-of-laws rules.

*          *          *
To obtain service or technical assistance within the continental U.S.A. and Alaska.

DIAL TOLL FREE: 1-800-LAPTOP5
Correspondence requesting product information should be sent
to: Panasonic Computer Solutions Company,
50 Meadowlands Parkway, Panazip 2F-5, Secaucus, NJ 07094

For U.S.A.
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PANASONIC COMPUTER AND PERIPHERALS LIMITED WARRANTY

Coverage – Panasonic Canada Inc. (“PCI”) warrants to you, the first end user customer, this computer product (excluding software media), when
purchased from PCI or from a PCI authorized reseller, to be free from defects in materials and workmanship under normal use, subject to the terms
set forth below, during the period of warranty coverage specified.

Remedy – In the event of a warranty claim, contact PCI’s representatives within the applicable warranty period, identifying the nature of the defect
claimed, at 1-800-668-8386 between 9:00 A.M. and 5:00 P.M., Eastern Time Zone, Mon. – Fri. (excluding holidays) for instructions on how to obtain
service.  A purchase receipt or other proof of date of original purchase is required before warranty service is performed. Defective parts covered by
this Limited Warranty will be repaired or replaced with new or comparable rebuilt parts on an exchange basis.  Warranty replacement or repair is
subject to the terms of this Limited Warranty for the balance of the original period of warranty coverage.

No Coverage – This Limited Warranty does not cover products purchased outside Canada.  Neither does it cover damage to, failure of, or defects in
a product or accessory through mishandling, improper installation, abnormal use, misuse, neglect, accident, introduction of liquid or other foreign
matter into the product, alteration or servicing by anyone not authorized by PCI, or act of God.

IF YOU SHIP THE PRODUCT FOR WARRANTY SERVICE
Carefully pack the product, preferably in the original carton.  Include details of defect claimed and proof of date of original purchase.  No liability is
assumed for loss or damage to the product while in transit, if you chose your own transportation carrier.

SOFTWARE MEDIA LIMITED WARRANTY

Coverage – Panasonic Canada Inc. (“PCI”) warrants to you, the first end user customer, that the disk(s) or other media on which software program(s)
is/are supplied will be free from defects in materials and workmanship under normal use in Canada for a period of sixty (60) days from date of receipt
as evidenced by your purchase receipt for your Panasonic Computer product.

THIS IS THE ONLY WARRANTY THAT PCI MAKES RESPECTING THE SOFTWARE MEDIA.  PCI does not warrant the software.  Please refer to the
software licensor’s written warranty (accompanying the copy of the software) for any software warranty claim.

Claim Procedure – In the event of a defect in material or workmanship in the media during the sixty (60) day warranty period, and you return it,
transportation costs prepaid, to Panasonic Canada Inc., Computer Products Marketing, at the above address, within the warranty period, together
with a copy of your purchase receipt, and an explanation of the suspected defect, PCI will replace in Canada the defective disk(s) or other media.

Remedy – PCI’s entire liability, and your only remedy for any breach of this software media warranty is limited to replacement of the media only.  It
does not cover any other damages, including, but not limited to, loss of use or profit loss, or special, indirect or consequential damages, or other
claims, whether or not of similar character.

No Coverage – This limited warranty does not apply if the disk(s) or other media has been used in other than a Panasonic product, or in environmen-
tal conditions other than those specified by PCI or the manufacturer, or if subjected to misuse, neglect, mishandling, modification or attempted
modification of the program, or if damaged by accident or act of God.   PCI is not responsible for damage to or loss of any program, data or removable
storage media.

GENERAL

NO OTHER WARRANTIES – PCI DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE, SOFT-
WARE MEDIA, COMPUTER PRODUCT, OPTIONS AND ACCESSORIES.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES – IN NO EVENT SHALL PCI BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUEN-
TIAL DAMAGES ARISING FROM ANY BREACH OF THE LIMITED WARRANTIES SET OUT IN THIS DOCUMENT, OR FROM THE USE OF THE
COMPUTER PRODUCT, INCLUDING, WITHOUT LIMITATION, LOSS OF DATA, BUSINESS, PROFIT OR GOODWILL.

IN ANY EVENT, PCI’S MAXIMUM LIABILITY FOR ANY BREACH SHALL NOT EXCEED THE AMOUNT ACTUALLY PAID BY YOU FOR THE
COMPUTER PRODUCT.
NO ACTION, REGARDLESS OF ITS BASIS, MAY BE BEGUN AGAINST PCI MORE THAN TWO (2) YEARS AFTER THE CAUSE OF ACTION
AROSE.

Statutory Warranties – Some jurisdictions do not allow these limitations or exclusions, so they may not apply to you.

Scope of Coverage
Whole Product (except Batteries), AC adaptor and CD-ROM
(if factory installed)
Batteries,  CD-ROM (unless factory installed), Port Replicator,
Extra Memory Modules and all other Peripherals, Options and
Accessories

Period of Coverage
Three (3) Years from Date of Original
End User Customer Purchase
One (1) Year from Date of Original End
User Customer Purchase

Type of Failure Coverage
Defective Materials or Workmanship

Defective Materials or Workmanship

For Canada

LIMITED WARRANTY
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Outline of the International ENERGY STAR® Office Equipment Program
The international ENERGY STAR® Office Equipment Program is an international program
that promotes energy saving through the use of computers and other office equipment.
The program backs the development and dissemination of products with functions that
effectively reduce energy consumption. It is an open system in which business proprietors
can participate voluntarily. The targeted products are office equipment such as computers,
displays, printers, facsimiles, and copiers. Their standards and logos are uniform among
participating nations.

As an ENERGY STAR® Partner, Matsushita Electric Industrial Co., Ltd. has
determined that this product meets the ENERGY STAR® guidelines for energy
efficiency.

Panasonic Computer Solutions Company,
50 Meadowlands Parkway, Panazip 2F-5,
Secaucus, NJ 07094

Panasonic Canada Inc.
5770 Ambler Drive Mississauga,
Ontario L4W 2T3

© 2003 Matsushita Electric Industrial Co., LTD.  All Rights Reserved.
Printed in Japan

FJ0803-0
DFQX5414ZA
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This manual contains supplementary instructions regarding the use of the computer. It ex-
plains the cases where the operation of the computer differs from that in the Operating
Instructions.
Your computer is equipped with GSM/GPRS enabling you to communicate using radio
frequencies.

Contents

Precautions .................................................................. 2

Names and Functions of Parts ................................... 5

Installing/Removing a SIM Card ................................. 7

Installing the Software................................................. 8

Appendix .................................................................... 13

Specifications ............................................................ 14

Supplementary Instructions

for GSM/GPRS

®

NOTE: NOTE provides a useful fact or helpful information.
CAUTION: CAUTION indicates a condition that may result in minor or moder-

ate injury.
Windows 2000 : Information for Microsoft® Windows® 2000 Professional users.
Windows XP : Information for Microsoft® Windows® XP Professional users.

[Start] - [Run]: This illustration means to click [Start], then to click [Run].
(For some applications, you may need to double-click.)

About the abbreviations in this manual, refer to the table on page 13.
Windows 2000 screens are used in this manual when no specific OS notes are re-
quired.

Illustrations and Terminology in this Manual
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The following safety precautions must be observed during all phases of the operation, us-
age, service or repair of any Personal Computer or Handheld Computer incorporating GSM/
GPRS modem. Manufacturers of the cellular terminal are advised to convey the following
safety information to users and operating personnel and to incorporate these guidelines into
all manuals supplied with the product. Failure to comply with these precautions violates
safety standards of design, manufacture and intended use of the product. Panasonic as-
sumes no liability for customer failure to comply with these precautions.

When in a hospital or other health care facility, observe the restrictions on the use
of mobiles. Switch Personal Computer or Handheld Computer incorporating GSM/
GPRS modem off, if instructed to do so by the guidelines posted in sensitive
areas. Medical equipment may be sensitive to RF energy.
The operation of cardiac pacemakers, other implanted medical equipment and
hearing aids can be affected by interference from Personal Computer or Handheld
Computer incorporating GSM/GPRS modem placed close to the device. If in
doubt about potential danger, contact the physician or the manufacturer of the
device to verify that the equipment is properly shielded. Pacemaker patients are
advised to keep their Personal Computer or Handheld Computer incorporating
GSM/GPRS modem away from the pacemaker, while it is on.

Switch off Personal Computer or Handheld Computer incorporating GSM/GPRS
modem before boarding an aircraft. Make sure it cannot be switched on inadvertently.
The operation of wireless appliances in an aircraft is forbidden to prevent interference
with communications systems. Failure to observe these instructions may lead to the
suspension or denial of cellular services to the offender, legal action, or both.

Do not operate Personal Computer or Handheld Computer incorporating GSM/
GPRS modem in the presence of flammable gases or fumes. Switch off the cellu-
lar terminal when you are near petrol stations, fuel depots, chemical plants or
where blasting operations are in progress. Operation of any electrical equipment
in potentially explosive atmospheres can constitute a safety hazard.

Your Personal Computer or Handheld Computer incorporating GSM/GPRS mo-
dem receives and transmits radio frequency energy while switched on. Remember
that interference can occur if it is used close to TV sets, radios, computers or inad-
equately shielded equipment. Follow any special regulations and always switch off
Personal Computer or Handheld Computer incorporating GSM/GPRS modem wher-
ever forbidden, or when you suspect that it may cause interference or danger.

Road safety comes first! Do not use a Personal Computer or Handheld Computer
incorporating GSM/GPRS modem while driving a vehicle. Do not place the com-
puter with GSM/GPRS modem in an area where it could cause personal injury to the
driver or passengers. It is recommended to stow the unit in the boot or secure stowage
area while driving.

Safety Precautions

Precautions
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Do not place the computer with GSM/GPRS modem in an area over an air bag or in the
vicinity where an air bag may deploy.
Air bags inflate with great force and if the computer with GSM/GPRS modem is
placed in the air bag deployment area may be propelled with great force and cause
serious injury to occupants of the vehicle.

IMPORTANT!
Personal Computer or Handheld Computer incorporating GSM/GPRS modem
operate using radio signals and cellular networks cannot be guaranteed to con-
nect in all conditions. Therefore, you should never rely solely upon any wireless
device for essential communications, for example emergency calls.
Remember, in order to make or receive calls, Personal Computer or Handheld
Computer incorporating GSM/GPRS modem must be switched on and in a ser-
vice area with adequate cellular signal strength.
Some networks do not allow for emergency calls if certain network services or
phone features are in use (e.g. lock functions, fixed dialing etc.). You may need to
deactivate those features before you can make an emergency call.
Some networks require that a valid SIM card be properly inserted in Personal
Computer or Handheld Computer incorporating GSM/GPRS modem.

Declaration of Conformity (DoC)
 “Hereby, we and Panasonic Testing Centre (Europe) GmbH (PTC), declares

that this Personal Computer is in compliance with the essential requirements
and other relevant provisions of the Directive 1999/5/EC.

Hint:
If you want to get a copy of the original DoC of our products which relates to the R&TTE, please
contact to our web address: http://doc.panasonic-tc.de

Compliance Notice - CE Mark
This equipment is in conformance with the requirements of the European Council Directive listed
below:
73/23/EEC   Low Voltage Directive with amendment 93/68/EEC
89/336/EEC  EMC Directive with amendments 92/31/EEC and 93/68/EEC
This Notice is based upon compliance of the product to the following standards:
EN60950
EN55022
EN61000-3-2
EN61000-3-3
EN55024
3GPP TS51.010-1: v4.9.0
EN 301 511: v7.0.1
EN 301 489 -1, -7
EN50385
Interface Cable
Use of an interface cable longer than 3 m (9.84 feet) is not recommended.

For Europe
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For U.S.A.

Radio frequency exposure information
In August 1996, the Federal Communications Commission (FCC) of the U.S. adopted an
updated safety standard for human exposure to radio frequency electromagnetic energy
emitted by FCC regulated transmitters. The design of this device complies with the FCC
guidelines and those standards.
To maintain compliance with FCC RF exposure guidelines, ensure the antenna is at least 1.5
cm from your body when transmitting. Use of non-approved accessories may violate FCC
RF exposure guidelines.

Precautions
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Names and Functions of Parts

SIM Card Slot

(  page 7)

Except the followings, refer to the Operating Instructions.

Antenna

(Appearance may differ depending on specifications.)

LED Indicators

(  page 6)
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LED Description

GSM/GPRS Switch
The GSM/GPRS modem powers up independently from the computer
regardless of the computer power status and will remain on when the
computer’s  power is off. This function depends on the setting of the
Setup Utility.

Power On Indication - Green:
A green LED will be used to signal when the GSM/GPRS modem has
been powered on.

Ring Indication - Amber:
The LED will flash when the GSM/GPRS modem has received a ring.

Status Indication - Green:
The LED will light while communicating.

Mode
Off

600 ms On/
600 ms Off

75 ms On/3 s Off

75 ms On/75 ms Off/
75 ms On/3 s Off
Flashing

On

Function
GSM/GPRS modem is off or running in SLEEP or
Alarm.
No SIM card inserted or no PIN entered, or network
search in progress, or ongoing user authentication,
or network login in progress.
Logged to network (monitoring control channels
and user interactions). No call in progress.
One or more GPRS contexts activated.

Indicates GPRS data transfer: When a GPRS
transfer is in progress, the LED goes on within 1
second after data packets were exchanged.  Flash
duration is approximately 0.5 s.
Depending on type of call:
Voice call: Connected to remote party.
Data call: Connected to remote party or exchange of
parameters while setting up or disconnecting a call.

Names and Functions of Parts
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1 Power off your computer and GSM/
GPRS modem

2 Installing a SIM card

Set the SIM card into the socket.

Turn the socket over.

Insert the socket to the SIM card slot.

Removing a SIM card

Press the button.
Remove the socket.

Remove the SIM card from the socket.

CAUTION

Do not insert the SIM card upside down.

Installing/Removing a SIM Card

Before using GSM/GPRS, set a SIM card to the SIM card slot.

CAUTION

Do not install/remove the SIM card when the GSM/GPRS modem’s power is on.

SIM Card

Socket
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Installing the Software

1 Turn on or restart the computer.
Press   F2   while [Panasonic] screen is displayed soon after

the computer begins the startup procedure.
If [Enter Password] is displayed, enter your password.

2 Select the [Advanced] menu and confirm the followings.

(  page 13)

The serial port’s setting is optimal.
[On & Off] is selected at [Power SYNC with PC].
If [On & Off] is not set, confirm the power to the GSM/GPRS modem is on.

3 Save the settings and exit the Setup Utility.

4 Set the software disc in the drive, then

input [x:\util\drivers\gprs\setup.exe]*1 in

[Start] - [Run] and select [OK].
Follow the on-screen instructions.

*1 “x” is the drive letter. You can change the letter to suit your
preference.

When the message on the right is displayed, select [OK].

5 At [Winmux Driver Setup] screen, select

[Start Scan].
All GSM/GPRS modems installed in the computer will
be listed in [Modem List].
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6 Confirm that the check mark is added

for the serial port you use and select [In-

stall Driver].
Installation will start.
(If the message “Digital Signature Not Found” is dis-
played, select [Yes].)
When the installation is complete, select [OK].

7 Select [Finish] to restart the computer.
After the computer is restarted, CheckNet runs automati-
cally.

8 Windows 2000
Select [Start] - [Settings] - [Control Panel] - [Phone and Mo-
dem Options] - [Modems].

Windows XP
Select [Start] - [Control Panel] - [Printers and Other Hardware]
- [Phone and Modem Options] - [Modems].

9 Select [Add].
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10 Add the check mark for [Don’t detect my

modem; I will select it from a list], then

select [Next].

11 Select [Have Disk].

12 Input [c:\program files\panasonic\

checknet*1\modem] and select [OK].
*1 This indicates the folder where CheckNet is installed in

step 4. This will vary depending on your computer’s setup.

13 Select your GSM/GPRS modem in the

list and select [Next].
To confirm the model number of your GSM/GPRS mo-
dem, run CheckNet and select [About].  (
checknet.pdf “Operating Instructions for using GSM/
GPRS”)

14 Select “Selected ports” and select the

com port for Virtual Port 1.
You can confirm the port number in [Device Manager]*1

- [Multi-port serial adapters] - [Serial Multiplexer] - [Port
Settings].
*1 Windows 2000 :

in [Start] - [Settings] - [Control Panel] - [System] -
[Hardware]
Windows XP :

in [Start] - [Control Panel] - [Performance and Main-
tenance] - [System] - [Hardware]

Installing the Software



11

15 Select [Next].
If the message “Digital Signature Not Found” is displayed, select [Yes].

16 Select [Finish].

17 Making extra settings for GPRS modem.

Select your GSM/GPRS modem and select [Properties] in [Phone and Modem Op-
tions] - [Modems].
In [Advanced], enter the extra initialization commands as follows. (  checknet.pdf
“Operating Instructions for using GSM/GPRS”)
AT+CGDCONT=<cid>,<pdp type>,<apn>
<RETURN>
Example: <cid>:1, <pdp type>:ip, <apn>:internet.t-d1.de
AT+CGDCONT=1,ip,internet.t-d1.de
<RETURN>
(Note that the APN shown here represents the German network provider T-D1 and
needs to be replaced with the APN address supplied by your own network pro-
vider.)

Select [OK].
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Uninstalling the Software

CheckNet
Use the following menu.

Windows 2000 : [Start] - [Settings] - [Control Panel] - [Add/Remove Programs]
Windows XP : [Start] - [Control Panel] - [Add or Remove Programs]

Wireless module multiplex driver
Select [Device Manager]*1-[Multi-port serial adapters]-[Serial Multiplexer] and uninstall
the driver.
*1 Windows 2000 : in [Start] - [Settings] - [Control Panel] - [System] - [Hardware]

Windows XP : in [Start] - [Control Panel] - [Performance and Maintenance] - [Sys-
tem] - [Hardware]

Installing the Software
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Wireless Modem

I/O IRQ 1*1

I/O IRQ 2*1

Power SYNC with PC

Setup Utility

The following parameters have been added in [Advanced] menu of the Setup Utility.

Disable Enable Auto

3F8/IRQ4 2F8/IRQ3 3E8/IRQ7 2E8/IRQ5

338/IRQ10*2

3F8/IRQ4 2F8/IRQ3 3E8/IRQ7 2E8/IRQ5

338/IRQ10*2

Independent On & Off Off Only

*1 This item is displayed only when [Wireless Modem] is set to [Enable].

*2 This item is displayed only for the model with a smart card slot.

APN Access Point Name
CID Context Identity
GPRS General Packet Radio Service
GSM Global System of Mobile Communication
IP Internet Protocol
PDP Packet Data Protocol
PIN Personal Identification Number
PLMN Public Land Mobile Network
PPP Point to Point Protocol
QoS Quality of Service
SIM Subscriber Identity Module
TCP Traffic Control Protocol

Abbreviations

Appendix
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Type

Class

SIM

RF Specification Transmit

Receive

Data Features Data

Fax

SMS

Voice Feature

Interface

GPRS Multi-Slot

Mobile Station

Specifications

Compliant with ETSI GSM phase 2/2+ standard

PCS1900 Class 1 (1 W)

Internal SIM card (3 V only)

PCS1900 (1850 MHz to 1910 MHz)

PCS1900 (1930 MHz to 1990 MHz)

asynchronous transparent & non-transparent

300 bps/ 1200 bps / 1200/75 bps / 2400 bps/ 4800

bps / 9600 bps / 14400 bps
facsimile group 3, Class 2

MT/PP(Mobile Terminating Short Message

Service, Point to Point)

MO/PP(Mobile Originating Short Message

Service, Point to Point)

CB (Cell Broadcast Short Message Service)

HR (Half rate)

FR (Full rate)

EFR (Enhanced full rate)

AT Commands (GSM 07.07)

Class 10

Class B
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Preface 
 

Welcome to the AT&T Wireless Communication Manager User Guide for Windows. This manual 

serves as the user guide for both enterprise and professional users. The software was created for 

use on the Global System for Mobile/General Packet Radio Service (GSM™/EDGE/GPRS). 

The purpose of this guide is to introduce you to each of the features, tools, and services that 

complete your new wireless solution, and to help you get up and running quickly, efficiently, and 

effectively. 

In addition to getting to know the AT&T Wireless Communication Manager application, you may 

also be learning about your new PC card or Next Generation phone. If you are using either of these 

devices but are not familiar with them, please read their accompanying user guides and 

documentation. 

  Technical Support 
If you have any questions or comments about the AT&T Wireless Communication Manager 
application, please contact your AT&T Wireless Technical Support Team. 

Account and 
Technical Inquiries 

1-866-293-4634 

URL attwireless.com  

  Specifications & Requirements 

General Client Requirements 
Wireless access is enabled using a Global System for Mobile/General Packet Radio Service 
(GSM™/ EDGE/GPRS) network with Next Generation phone or PC card. To use the AT&T 
Wireless GSM/EDGE/GPRS service, you must have a GSM/EDGE/GPRS device (phone or PC 
card), an AT&T Wireless Mobile Internet plan, and AT&T Wireless Communication Manager 
software. 

Note: AT&T Wireless Communication Manager must be installed before inserting the PC card as 
the software includes the latest drivers necessary for the PC card, which your Microsoft operating 
system may not include. 

Minimum System Requirements 
Operating System 
 

§ Notebook computer with one of the following Microsoft operating systems: 
§ Windows® XP Professional or Windows® XP Home 
§ Microsoft® Windows® 2000 with Service Pack 3.0 or higher 
§ Microsoft® Windows® Me 
§ Microsoft® Windows® 98 with Internet Explorer (IE) 5.0 or higher 
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Storage & Drives § Hard disk storage of about 12 MB of available space for the 
Communication Manager software and User Guide 

§ CD-ROM drive 

Communication 
Interface-Support 

§ One of the communication port to enable connectivity to wireless device: 
§ Nine pin RS-232 communication port to interface with handset via 

cable 
§ PC Card communication port to interface with a GPRS/EDGE PC Card 
§ Infrared communication port to interface with handset using infrared 
§ Bluetooth communication port to interface with handset device us ing 

Bluetooth. 

Memory • NO additional memory (RAM) requirements beyond that of the specific 
memory requirement of the version of the operation system (Windows)  

Software § AT&T Wireless Communication Manager software 

 

Software Versions 
AT&T Wireless Communication Manager client software version 2.0.  
The software includes the following two components: 

§ Connection Manager version 1.9 or higher 

AT&T Wireless 
Software 

§ Optimization Manager  

 

EDGE/GPRS Service Support 
EDGE/GPRS Service supports the following protocols: 

HTTP LDAP IMAP4 DNS 

HTTPS WAP Telnet NTP 

NNTP POP3 SSH SNTP 

FTP SMTP IRC Ping (ICMP) 
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Connection Devices 
 

Your PC card or Next Generation phone will provide you with wireless access to the AT&T Wireless 

GSM/EDGE/GPRS network, allowing you to easily navigate the Web, and your corporate intranet. 

  Supported Devices 
You can use your Next Generation phone in conjunction with your laptop as a way to connect to 
the Internet though AT&T Wireless Communication Manager. Alternatively, you can connect to 
the EDGE/GPRS network using a EDGE/GPRS PC card installed in your notebook computer. The 
table below identifies the phones and PC cards supported by AT&T Wireless Communication 
Manager.  

To use your phone or PC card as a connection device, however, you must first ensure that your 
phone or PC card has an AT&T Wireless SIM card installed to provide you with wireless activity. 
See Using Your AT&T Wireless Mobile Internet SIM Card  on page 4 for more information on SIM 
cards. 

Supported Devices 
PC Cards § SonyEricsson       GC82 PC Card  

§ Sierra Wireless    AirCard™ 710, 750  
§ Novatel                 Merlin™ G100 
 

Next Generation 
Phones 

• Motorola             C333, T720, V.60 
• Nokia                  3650, 5100, 6200, 6310, 6310i, 6800, 7210 
• Panasonic          GU87 
• Samsung            V206 
• Siemens              S46, M56, SL56 
• SonyEricsson     P800, T306, T616, T68i 
 

Communication 
Manager Cables 

Note: Communication Manager cables are used to connect wireless phones with 
the laptop — supported wireless phones can be used to establish a connection 
in place of a PC card. Additional accessory information can be found at 
attwsaccessories.com. 

PC Card Safety 
PC Card Safety Information 

Novatel G100™ PC card The Novatel G100™ PC card is required to comply with the Federal 
Communications Commission (FCC) radio frequency (RF) exposure 
requirements for mobile transmitting devices. A separation distance of 17 cm or 
more must be maintained between the antenna and all persons during device 
operations to satisfy RF exposure compliance. 
The Novatel G100™ PC card has been certified to comply within the limits of a 
class B digital device pursuant to part 15c of the FCC rules. These limits are 
designed to provide reasonable protection against harmful interference in 
residential situations. This equipment generates, uses, and can radiate radio 
frequency energy, and, if not properly installed and used in accordance with the 
instructions, may cause harmf ul interference to radio or television reception, 
which can be determined by turning the equipment on and off. You are 
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encouraged to try to correct the interference by one or more of the following 
measures: 

§ Re-orient or relocate the receiving antenna of the television, radio, or 
cordless telephone. 

§ Increase the separation distance between the equipment and the receiver. 
§ Connect the equipment to an outlet on a circuit different from that to which 

the receiver is connected. 
§ Consult the dealer or an experienced radio/television technician. 

Sierra Wireless AirCard® 
710 & AirCard® 750 PC 
card 

In August 1996 the Federal Communications Commission (FCC) of the United 
States with its action in Report and Order FCC 96-326 adopted an updated 
safety standard for human exposure to radio frequency (RF) electromagnetic 
energy emitted by FCC regulated transmitters. Those guidelines are consistent 
with the safety standard previously set by both U.S. and international standards 
bodies. The design of this wireless network card complies with the FCC 
guidelines and these international standards. 

Use only the supplied or an approved antenna. Unauthorized antennas, 
modifications, or attachments could impair call quality, damage the phone, or 
result in violation of FCC regulations. 
The AirCard 710 and 750 PC cards have been tested for FCC RF exposure 
requirements in a laptop. To comply with FCC RF exposure requirements, the 
AirCard must be operated with a minimum separation distance of 2.0 cm (0.8 
inch) between the user/nearby persons and the antenna. 

For more information about RF exposure, please visit the FCC Web site at 
http://www.fcc.gov. 

 

  Using Your AT&T Wireless Mobile Internet SIM Card 
The AT&T Wireless Mobile Internet SIM card is a small card with an embedded microchip in it, 
which provides you with secure access to the AT&T Wireless GSM/EDGE/GPRS network once 
it’s installed in your modem or network PC card or Next Generation phone (the Bluetooth PC card 
does not require a SIM). 

AT&T Wireless Services programs the microchip for you with your account specifications 
including your U.S. wireless number, optional features, and billing information. 

Notes About SIM Cards: 
§ Keep all SIM cards out of reach of children. 

§ The orientation notch on the card is used as a reference for inserting the card into the phone 
(see Figure 1). 

§ Contact points on the card are used to make a connection with the device (see Figure 1). 

§ The SIM card and its contact points are easily damaged by scratches or bending, so use care 
when handling, inserting, and removing the card. 

§ Because battery removal may be required to access the SIM card, always ensure that the 
phone is turned off before removing the battery. 

Contact
PointsOrientation

Notch

 
Figure 1. AT&T Wireless Mobile Internet Plan SIM Card 
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Getting Started with 
the AT&T Wireless 

Communication 
Manager 

 

This section describes how to configure and install the AT&T Wireless Communication Manager 

software on your laptop equipped with Microsoft® Windows 98, Windows® Me,  

Windows® XP Professional, or Windows® 2000 Professional. 

  Software Installation for Windows 
Your first step in getting started with AT&T Wireless Communication Manager for Windows is 
installing and configuring the software. The steps below will guide you through this process. 

To install the software on your computer: 
1. Insert the AT&T Wireless Communication Manager CD-ROM into the CD-ROM drive on 

your laptop. The Communication Manager Installation window opens automatically. 

2. Select the Windows  installation option. 

3. Follow the instructions on the screen to complete the installation. 

 

Installing the software on Windows XP: 
The Communication Manager software includes EDGE/GPRS communication drivers for the 
supported EDGE/GPRS devices. In Windows XP Microsoft added a warning screen for driver it 
doesn’t recognize. Since some of the EDGE/GPRS drivers are newer than Windows XP you may 
receive the warning message. Please select Continue Anyway as the drivers are safe and truly 
tested by the device manufacture and by AT&T Wireless. 

 
Figure 2. Continue Installation 
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Uninstalling the Application 
On the occasion you need to uninstall the application from your laptop, follow the steps below. 

To uninstall the software application from your laptop: 
1. On your Windows  toolbar, click Start to open the Start menu. 

2. Click Settings > Control Panel to open the Control Panel window. 

3. Click Add/Remove Programs  to open the Add/Remove Programs Properties  dialog box, 
and then click the Install/Uninstall tab (if it is not already selected). 

4. In the Programs  list box, select AT&T Wireless Communication Manager from the list of 
installed programs on your computer (you may need to scroll), and select it. 

5. Click Add/Remove  to start the uninstall process. 

6. You will be asked to verify that you wish to completely remove the selected application and 
all of its components. Click OK to confirm the deletion and begin the uninstall process, or 
click Cancel to cancel the process and return to the Add/Remove Programs Properties  
dialog box. 
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  Starting the Application 
Getting started with the application can be done in a click: 

§ Clicking the AT&T Wireless Globe icon in the system tray. 

– OR – 

§ Selecting AT&T from the Start > Programs  menu. 

– OR – 

§ Clicking the shortcut on your desktop (if created during the install process). 

Any of the options above will open the AT&T Wireless Communication Manager tool and display 
the Communication Manager main screen (see Figure 3). The tool you need to use first in order 
to configure your EDGE/GPRS device is the Connection Manager. 

 
Figure 3. Communication Manager Main Screen 

Note: The first time you start the application, the Connection Manager Device Selection Wizard 
starts automatically and walks you through the process of detecting a port and establishing your 
connection preferences (see Figure 4).  
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  Device Selection Wizard 
The first time you start Communication Manager, the Device Selection Wizard (Figure 4) will 
display over the top of the application. The wizard is short step-by-step process used to help you 
configure your wireless connection device — select the connection type you wish to use and then 
click Next. The wizard will begin searching for a EDGE/GPRS device. 

 
Figure 4. Device Selection Wizard 

Continue clicking Next on each screen to advance through the wizard. You will know you are 
finished when you are prompted to click Finish to exit and close the wizard. 
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Device Selection Wizard Couldn’t Find Your EDGE/GPRS 
Device? 
If the Device Selection Wizard is unable to locate the EDGE/GPRS hardware required to establish 
a wireless connection (EDGE/GPRS hardware includes your PC card, Communication Manager 
(serial) cable, infrared, or Bluetooth ports on your phone and laptop), the following screen will 
display: 

 
Figure 5. Device Selection Wizard (No EDGE/GPRS Device Found) 

If no device was found, the list below may help you troubleshoot the issue: 

§ Modem/network card users  — Verify that your PC card is properly inserted into your 
laptop. 

§ Communication Manager cable users  — Verify that both ends of the Communication 
Manager (serial) cable are properly and firmly attached. 

§ Infrared users  — Verify that the infrared port on your phone and laptop are activated and 
that the two infrared ports are aligned (12 inches apart or less). 

§ Bluetooth users  — Verify that your PC card is properly inserted in your laptop and that your 
phone is in “Dis coverable” mode. Also, verify that the Bluetooth drivers on your laptop are 
version 1.2.1.12 GR15 R4 or later. Drivers can be downloaded for free from IBM.com. 

You can always run the Device Selection Wizard from the Connection Manager main screen, by 
clicking File > Device Selection Wizard. For more information about the Connection Manager 
tool, see Managing Connections on page 14. 

Need Help?  For AT&T Wireless Customer Service, please call 1-866-293-4634. 
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Using AT&T Wireless 
Communication Manager 

 

Once you’ve established a wireless connection, you’ll want to familiarize yourself with each of the 

tools and services within AT&T Wireless Communication Manager. The following information will 

guide you through the application and answer basic questions about each tool and service. 

Introducing AT&T Wireless Communication Manager 
Getting to know the basic layout of the AT&T Wireless Communication Manager application will 
help you locate the various tools and services more quickly. 

Communication Manager main screen is your central location point to access the tools, the 
Internet, and other applications available from the main screen. 

 
 

The main screen provides access 
to the following: 

§ Connection Manager — 
Enables you to set your 
EDGE/GPRS device quickly 
and easily in addition to 
providing many tools and 
services to inform and 
diagnose your current and 
past connectivity sessions. 

§ Optimization Manager — 
Optimizes your wireless 
connection throughput 
through compression and 
acceleration of downloaded 
traffic.  

§ Office Online -Takes you to 
www.startofficeonline.com 
to log into your Office 
Online Account 

 

 
Figure 6. Communication Manager Main Screen 

 

§ Connection Status  — Identifies whether the device is connected or disconnected from the 
EDGE/GPRS network. 

§ Optimization Status  — Indicates whether the Optimization feature is enabled or disabled. 
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  Connection Manager 
The Connection Manager provides connectivity to the AT&T Wireless EDGE/GPRS network. It 
includes tools used to detect and configure your device, as well as monitoring and troubleshooting 
connection issues. 

 
Figure 7. Communication Manager Main Screen (Configured with PC Card EDGE/GPRS 
Device) 

 

The main status window contains general connection controls, the functions menu, and indicators 
showing the status of the wireless connection.  

§ Connect — Used to establish a connection to the AT&T Wireless EDGE/GPRS network. 
This button is grayed out if a connection exists. 

§ Other connections  — Allows you to select another connection type. Connection types 
include EDGE/GPRS data services (gateways) as well as more traditional dial-up connections 
(e.g. when in GSM coverage only). 

§ Connection type  — Next to the buttons within the Connection group box is an icon that 
represents the current connection type (e.g. serial cable, infrared, PC card, Bluetooth™ etc.).  

§ Progress —  The graphical Progress button allows a set of progress bars/data counters that 
indicate data transmitted and received from the network using your EDGE/GPRS phone 
(during a connection). The mode of these indicators can be toggled between data rate and data 
transferred. 

§ Graphical indicators  — The graphical indicators at the far right of the screen (see Figure 7) 
show the signal strength and connection readiness. These icons are not available for all 
connection or network types and may not always display. 

§ File, Tools, and Help menus — Connection Manager contains a menu structure that allows 
access to the various functions of the software. A reduced form of this menu also appears by 
clicking the phone icon in the system tray. 

ú File — The File menu provides another way to connect or disconnect, and provides 
access to the Device Selection Wizard. 

ú Tools — The Tools menu provide access to several tools, such as, creating new 
connections, reviewing connection log, viewing device/phone information, and 
modifying the Connection Manager options. 

ú Help — Connects you to the help system within the software. 
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§ Closing and exiting  — To close the Connection Manager, click the close box in the 
upper-right corner of the program window. Note that closing the Connection Manager will 
only close the windows, but the program will continue to run until you exit it. You can access 
the program directly by clicking the phone icon in the system tray. To exit Connection 
Manager, click File > Exit. Or, click the phone icon in your taskbar and select Exit from the 
menu. 
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Connecting/Disconnecting from the EDGE/GPRS Network 
To connect: 
There are multiple ways you can connect to AT&T Wireless EDGE/GPRS network: 

§ In Communication Manager main screen, click File > Connect. 

– OR – 

§ Right-click the AT&T Wireless Globe icon  in the system tray, then click Connect. 

– OR – 

§ On the Connection Manager main screen, click the Connect button. 

 

To disconnect: 
To disconnect or to end the EDGE/GPRS session, you can use any of the above ways to connect. 
The menu options or buttons will automatically display Disconnect to disconnect and end the 
session. 

Pre-Call Check 
The pre-call check is a set of tests used to determine that Communication Manager can 
communicate with your EDGE/GPRS device, that the device is EDGE/GPRS ready, and that it 
can communicate with the EDGE/GPRS network.   The pre-call check occurs if a device is unable 
to connect in order to attempt to diagnose the problem. 

 
Figure 8. Other Manual Connect Options 

You can run it manually by clicking the pre-call check icon using the Other Connection button 
(instead of the Connect button) in the Connection Manager main window (see Figure  7).  



 

 

AT&T Wireless Communication Manager Software User Guide for Windows  Page 14 

 

Managing Connections 
Connections to data services can be managed (e.g. added, edited, deleted) by clicking Tools > 
Manage Connections .  

The Manage Connections window  (see Figure 9) presents a list of dial-up and EDGE/GPRS 
connections in the Existing Connections  list box that can be edited or deleted. Ne w connections 
can be created here as well. The default setup can be restored to the original settings in the event 
of a serious error or device malfunction. 

 
Figure 9. Manage Connections 

To manage your connection preferences: 
In the Existing Connections window, select your existing connection (network) preference, and 
then: 

§ Edit — Click this button to access the Connection Wizard and edit the settings for the 
selected connection. 

§ Delete — Click this button to delete this preference (you will be asked to confirm the deletion 
before it is deleted). 

§ New — Click this button to add a new connection preference using the Connection Wizard. 

§ Use — Click this button to select one or more existing Dial-Up Networking connections (for 
dial-up mode) 

§ Close — Click this button to close the Existing Connections tool and return to the Connection 
Manager main screen. 

§ Restore Default Settings — Click this button to restore the preconfigured software settings. 
This function is useful for disaster recovery where original connections have been edited, 
deleted, or overwritten and have resulted in loss of connection capability to the original data 
services supplied with the software. 
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Creating New Connection 
You can create your own connections by clicking Manage Connections  > New. Creating a new 
connection starts the new connection wizard that steps you through the settings process 
(see Figure 10). 

 
Figure 10. Creating New Connection Wizard (first screen) 

 

Note: For AT&T Wireless Customer Service, please call 1-866-293-4634. 

Performing a Diagnostic Test 
The Diagnostics function (available by clicking Tools > Diagnostics) is helpful in troubleshooting 
issues with the EDGE/GPRS device or computer that are prohibiting connectivity. 

 
Figure 11. Diagnostics 

The names of the diagnostic tests appear in the left column along with an icon representing the 
result of the test. The next column indicates any abnormal result. The last column indicates any 
recommended way of resolving the problem. At the bottom of the screen is an area for overall 
diagnostic status. Additional functions include: 

§ Run — Re-runs the diagnostic tests and displays the new results. 

§ More Info — Provides additional information about a selected diagnostic test. To receive 
more info about a particular test, highlight it, and then click More Info. 

§ Close — Closes the Diagnostics window 



 

 

AT&T Wireless Communication Manager Software User Guide for Windows  Page 16 

 

Diagnostic Test Definition 
The following is a list of each diagnostic test with details of what it does and what to do if it fails: 

§ Port Presence —Ensures that the communication port, which the computer is using to 
communicate with the phone, is properly configured on the computer’s operating system. A 
failure generally indicates a serious operating system problem where the port that the phone 
was originally configured on no longer exists (i.e. the operating system on the computer can 
no longer access the port because it is not configured).  

§ Port Configuration  — Ensures that the computer can access the communication port used to 
communicate with the phone. A failure generally indicates that the communications port is in 
use by another application (e.g. synchronization software, fax software etc.). Investigate what 
other software is running on your computer and disable anything that ordinarily uses 
communication ports, then re-run the diagnostic.  

§ Communication Device Presence — Determines whether the device is present on the 
communications port is capable of responding to “AT” commands. This device could be for 
which the test is searching, or another type of modem or device. Failure of this test tends to 
indicate that the phone is not powered on, the cable is not connected properly (if serial), the 
infrared port is not enabled on the phone, or the phone is not pointing correctly for infrared 
use (if infrared). Check your setup carefully to ensure all cabling is connected properly or 
infrared is setup and visible (as appropriate).  

§ Phone Communication Ability  — Determines whether the device present is actually a 
EDGE/GPRS phone that can be used with this software. Failure of this test generally occurs 
when the attached device is an unsupported modem (e.g. a wireline modem) or other kind of 
device. It can also indicate that the attached phone is not supported by this software version. 
In this case, try to obtain an updated version of this software.  

§ Phone Battery Status  — Determines whether there is  sufficient battery strength for a 
connection to proceed. Battery strength of less than 15% is considered low and a warning 
would be displayed.  

§ Current Network Availability — Determines whether there is a digital network present and 
that there is sufficient signal strength to use it — it also tests if EDGE/GPRS is available in 
this area and at this time. Signal strength of less than 20% is considered low and a warning 
would be displayed. If the available network is GSM only or EDGE/GPRS is not yet attached, 
a warning is displayed (Note: EDGE/GPRS calls are not possible on GSM -only networks). 

 

Device/Phone Information 
The phone information function (Tools  > Phone Information) is helpful in extracting information 
from the EDGE/GPRS phone (or other EDGE/GPRS device). This information is particularly 
useful during a call with AT&T Wireless Customer Care. It contains information including the 
manufacturer, model and software versions of the phone (or other device) being used. 

 
Figure 12. Device/Phone Information 
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  Optimization Manager 
The Optimization Manager allows you to select the efficiency settings on your laptop. Optimizing 
your laptop allows you to download Web pages and images more quickly. You can also verify the 
status of the optimization feature, and enable and disable it at your discretion. 

The Optimization feature also allows you to activate additional tools, including content blocking 
and image quality settings, and set various protocols used to access your POP3 e-mail accounts.  

Use Optimization is a global setting and is enabled by default. 

 
Figure 13. Optimization Global Settings 

Optimization Status 
The optimization status settings include: 

§ Enabled — Indicates that the Optimization feature is enabled (default setting) 

§ Idle or Optimizing  — Indicates that the optimization is active and optimizing data traffic 

§ Disabled — Indicates that the Optimization feature is disabled 

§ Bypass — Indicates that optimization is enabled but failed to optimize the current 
data transfer 
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Understanding Optimization Manager Setting in 
Microsoft Internet Explorer 
The Optimization Manager uses proxy setting in Microsoft Internet Explorer (IE) to optimize 
traffic through its engine. Although we do not recommend manually setting the proxy in your 
browser, the following identifies the default settings. 

§ HTTP: Set to “localhost,” port “9090” 

§ Secure: Set to “localhost,” port “9092” 

§ FTP: Set to “localhost,” port “9093” 

IMPORTANT!  Optimization Manager requires IE 5.0 or above to function. To upgrade to IE 5.0 
or above, visit Microsoft.com for more information and free browser downloads. 

Setting the Image Quality 
The Image Quality feature determines the quality of images you view while browsing as well as 
the performance of your laptop where: 
§ Lowest image quality, highest speed reduces image clarity, so images are less vibrant and 

detailed. Because there is less detail to load, you’ll see shorter screen-loading times. 

§ Medium-image quality, medium speed loads generally clear images. Screen-loading times 
may take some time when browsing wirelessly. This is the default setting. 

§ Highest image quality, lowest speed provides you with crisp, clear images when wirelessly 
browsing the Internet although screen-loading times may be lengthy. 

Tip: Clear the cache directory in your browser by opening the browser window and clicking 
Tools > Internet Options  > Delete Files .  

 
Figure 14. Optimization Manager — General Tab 
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Blocking Content 
Blocking particular types of content is useful when trying to maximize the performance of your 
laptop while browsing. Animation, applets, audio, and video heavily tax the speed at which your 
laptop can download information. Preventing these types of content from loading can speed up 
download times and improve overall performance. 
The blocking features are: 

§ Animation — Blocks animated files, such as animated GIF files 

§ Applets  — Blocks applets, such as Java applets 

§ Audio — Blocks audio files, such as WAV files 

§ Images — Blocks image files, such as GIF, JPG, and BMP files 

§ Video — Blocks video content, such as AVI or MPEG files 

 
Figure 15. Optimization — Blocking Tab 

To set the Blocking feature: 
1. From the Communication Manager main screen, click Optimization Manager > Content. 

2. Select the check boxes next to the content types that you want to block while wirelessly 
browsing the Internet. These options include: Animation, Applets , Audio, Images , and 
Video. The default is set so that none are selected (i.e., all download and display). 

3. Click OK to save your settings and return the Communication Manager main screen, or click 
Cancel to return to the main screen without saving your changes. 

Tip: Clear the cache directory in your browser by opening the browser window and clicking 
Tools > Internet Options  > Delete Files . 
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Setting Personal E-Mail Messaging Protocols 
Setting or configuring your personal Internet protocols enables you to optimize the newsgroup 
information and e-mail you receive, as well as the e-mail you send through your personal e-mail 
client program (e.g., Outlook, MSN). 
For each protocol you wish to use, you will need to include an associated port number. Your 
message traffic will be compressed and forwarded based on the settings you provide. The default 
values for port fields are: 

§ POP3 — 110 

§ IMAP — 143 

§ SMTP — 25 

 
Figure 16. Optimization — Messaging Tab 

The email client (Outlook, Outlook Express, etc.) must be configured so that input and output 
settings are set to "localhost" or "127.0.0.1". 

Note: This feature is only enabled if Optimization is set to Enabled. To enable the Optimization 
feature, see Optimization Manager on page 17. 
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To set up POP3: 
1. From the Communication Manager main screen, click Optimization Manager > Messaging . 

2. If you wish to connect to a POP3 server, type the server’s IP address or hostname in the 
POP3 text field, and then type the server’s port number in the corresponding Port text field. 

If you do not wish to connect to a POP3 server, type “no” in the POP3 text field, and leave 
the Port text field set to the default value. 

3. If you wish to connect to an IMAP server, type the server’s IP address or hostname in the 
IMAP text field, and then type the server’s port number in the corresponding Port text field. 

If you do not wish to connect to an IMAP server, type “no” in the IMAP text field, and leave 
the Port text field set to the default value. 

4. If you wish to connect to an SMTP server, type the server’s IP address or hostname in the 
SMTP text field, and then type the server’s port number in the corresponding Port text fie ld. 

If you do not wish to connect to an SMTP server, type “no” in the SMTP text field, and leave 
the Port text field set to the default value. 

5. Click OK to save the new settings, or click Cancel to close the dialog box without saving the 
new information. 
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Maintaining Your Connection 
The Communication Manager software is automatically configured to search for a EDGE/GPRS 
connection each time you connect to the Internet. If you are having trouble establishing a 
connection, verify that the software is still configured to look for EDGE/GPRS. 

 

Network Selection Tool 
 
The network selection tool is designed to work with PC cards like the Sierra AirCard 750 and the 
Sony Ericsson GC-82. This document explains how to use the Network Selection Tool provided 
with Connection Manager. 
 
1. On the Tools menu, click Select Network . 

  
Figure 17 Select Network  

Note: A network name will not be displayed in the Network Status Box until a connection is 
made, network is selected or the phone information test is run.  
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2. The Network Selection screen opens and it automatically starts scanning for available 
networks. The scrolling phone icon is displayed while scanning for networks. 

   
Figure 18 Network Selection Scan 

 
3. Once the network scan is complete, the Network Selection screen is displayed.   

  
Figure 19 Choosing a Network 
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Note: the first network name displayed may not be the active network. The network name is 
displayed in the same order that the device gives the information and different devices may do 
different things. 
 
4. In the Network Selection screen, click Manual or Automatic/Manual to change networks. 

   
Figure 20 Selecting Manual Network Selection 

   
 
   
 
5. In the Network  list, click the network you want to use. 

   
Figure 21  Choose Network 
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5. In the Network Selection screen, click OK to use the selected network. 

   
Figure 22  Network Selection 

 
6. The selected network is displayed on the Main Window. 

  
Figure 23  Display Network Selection 

  
  
7. Click Refresh List to re-scan for networks. 
 
8. Click Cancel at any time to exit the Network Selection. 
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Glossary 
 

Cache Memory Cache memory is random access memory (RAM) that a computer 
microprocessor can access more quickly than it can access regular RAM. 

Driver A software routine that links a peripheral device to the operating system. It 
acts like a translator between a device and the applications that use it. Each 
device has its own set of specialized commands known only to its driver. In 
contrast, most applications access devices by using high-level, generic 
commands. The driver accepts these generic commands and translates them 
into the low-level specialized commands required by the device. 

Federal 
Communications 
Commission (FCC) 

A U.S. government agency responsible for regulating communications 
industries; it was established by the Communications Act of 1934. The Act, 
which has been amended over the years, charges the Commission with 
establishing policies to govern interstate and international communications by 
television, radio, wire, satellite, and cable. 

General Packet Radio 
Service (GPRS) 

GPRS is a popular 2.5G technology that is being implemented in GSM 
networks. This IP-based packet-data switching system more closely 
resembles the Internet than a direct line. It is ideal for sending “bursty” packets 
of data through an open channel and only uses the network when s ending 
data. All standard Internet protocols can operate over GPRS — TCP, UDP, 
HTTP, SSL, and IPSec. 

Global System for 
Mobile (GSM) 
Communication 

A digital communication technology used by some carriers to provide PCS 
service. Other technologies used are CDMA and TDMA. 
GSM is a digital circuit-switched protocol that moves data at rates up to 
14.4 Kbps. As the name declares, it is used globally; however, roaming is not 
always possible because GSM currently runs on different frequencies in 
different countries. 

Handset Wireless phones that have data capability: 
§ Class A handsets can do both voice and data simultaneously.  
§ Class B handsets are voice and packet data capable, but not at the 

same time.  
§ Class C handsets can handle packet data only (or they can be set manually 

to handle one or the other). 
 

Infrared A method of transmitting data via infrared light waves. Increasingly, computers 
and other devices (such as printers) come with Infrared Data Association 
(IrDA) ports. This enables you to transfer data from one device to another 
without any cables. IrDA ports support roughly the same transmission rates as 
traditional parallel ports; however, the two devices must be within a few feet of 
each other and there must be a clear line of sight between them. 

Infrared Port Enables you to exchange data with other Windows -powered devices. 

Internet The global computer network, which is composed of thousands of WANs and 
LANs that uses TCP/IP to provide worldwide communications to homes, 
schools, businesses, and governm ents. The WWW runs on the Internet. 
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Internet Protocol (IP) The protocol, or set of rules, that performs the addressing function of the 
Internet. Every packet of data traveling over Internet networks includes an IP 
address of its destination and of its sender. Routers and other devices to direct 
Internet traffic to its proper destination use this IP address. 

Kilohertz (kHz) One thousand cycles per second; a unit of measure for frequency. 

Local-Area Network 
(LAN) 

A computer network technology designed to connect computers separated by 
a short distance. The local group of linked computers is generally connected to 
a single, shared server. 

Megahertz (MHz) One million cycles per second; a unit of measure for frequency. 

PC Card (Modem) A device that you connect to your computer and to a phone line, that allows 
the computer to talk to other computers through the phone system. Basically, 
PC cards do for computers what a telephone does for humans. 

Operating System 
(OS) 

The software controlling the overall operation of a multipurpose computer 
system, including such tasks as memory allocation, input, and output 
distribution, interrupt processing, and job scheduling. 

Optimization A feature that is an advanced performance accelerator for TCP/IP-based 
wireless applications such as e-mail, vertical enterprise applications, and Web 
browsing. The AT&T Wireless Communication Manager Optimization feature 
offers unique compression, acceleration and content adaptation techniques to 
dramatically improve bandwidth utilization for wireless data applications. It 
allows the user to retain total “on-the-fly” control of the type and quality of 
content they receive. It also provides performance improvement over native 
wireless services that increases productivity, decreases airtime/per packet 
charges, and enables three times the number of users on the wireless data 
infrastructure. 

Protocol A set of rules or standards that enable computers to connect with each other 
to exchange information. 

Random-Access 
Memory (RAM) 

The PC’s primary storage area, used to write, store and retrieve information 
and program instructions, which are then passed to the CPU for processing. 
The type of RAM used affects performance, as the information stored here has 
to be refreshed many times per second by the processor. Manufacturers are 
continually coming up with new designs to provide the fastest possible access 
times at the lowest possible cost. 

Read-Only Memory 
(ROM) 

An integrated circuit chip containing programs and data that can be accessed 
and read but cannot be modified. 

Transmission Control 
Protocol/Internet 
Protocol (TCP/IP) 

The communications protocol used by UNIX systems and the Internet. TCP 
checks for lost packets, puts the data from multiple packets into the correct 
order and requests that missing or damaged packets be resent. 

 




